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QUESTION 1: 
 
Joe wants to display a company logo throughout his sales application. In which one of the following 
places can Joe display the graphic? 
 
A. In a view background 
B. In a layer background 
C. In an action bar background 
D. All of the above 
 
Answer: A 

 
QUESTION 2: 
 
Eduardo chose Native OS style (Use native control) when he created an editable text field on a form. In 
which one of the following ways will the field appear to Notes users? 
 
A. Fixed-size outlined rectangle. 
B. Blank space marked off by red brackets. 
C. Blank space marked off by black brackets. 
D. Blank space marked off by black brackets. 
E. The field will not appear to Notes users. It will only be visible to Web users. 
 
Answer: A 

 
QUESTION 3: 
 
AJ wants to create a new application on his laptop that does not have any design elements in it. Which 
one of the following should he do to begin this process? 
 
A. Select File>Database>New and give it a filename of "blank.nsf". 
B. Select File>Database>New, choose local as the server and choose the blank template. 
C. Select File>Database>New, choose local as the server and choose the default.ntf template. 
D. Select File>Database>New, give it a filename of "blank.nsf" and choose the blank template. 
 
Answer: A 

 
QUESTION 4: 
 
Silvio wants to allow Jackie to create and modify documents in his Video application, but he doesn't want 
Jackie to make a local replica or copy of the database. Which one of the following should Silvio do to 
accomplish this? 
 
A. There is no way for Silvio to do this. 
B. Give Jackie Author access on the database ACL. 
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C. Give Jackie Editor access and deselect "Replicate or copy documents" in the database ACL. 
D. Give Jackie Editor access on the database ACL and assign him to the a role that prevents him from 
replicating or copying documents. 
 
Answer: C 

 
QUESTION 5: 
 
Carmine has created a new design for the Video application. Carmine would like to post the design to the 
server and make it available so other databases can automatically inherit the design changes when the 
DESIGN server tasks run. Which one of the following should Carmine to do make the new design 
available on the development server? 
 
A. Copy the database to the development server and name it "newvideo.ntf". 
B. Copy the database to the development server and name it "newvideo.nsf". 
C. Copy the database to the server, name it "newvideo.ntf", select "Inherit design from master template" and 
give it a template name in the database Design properties. 
D. Copy the database to the development server, name it "newvideo.ntf", select "Database file is a master 
template" and give it a template name in the database Design properties. 
 
Answer: D 

 
QUESTION 6: 
 
Tony wants to create a duplicate of the Video application. He wants to keep a version of the data on the 
same server as the production application but does not want any new documents or document 
modifications to be replicated into his new database once he creates it. Which one of the following should 
Tony do to create his archive? 
 
A. Create a new copy of the database. 
B. Create a replica copy of the database. 
C. Use Windows Explorer to create a copy of the database file. 
D. Create a replica copy of the database and disable replication on the database properties. 
 
Answer: A 

 
QUESTION 7: 
 
Which one of the following database elements is NOT updated when the DESIGN task is run? 
 
A. Forms 
B. Views 
C. Roles 
D. Agents 
 
Answer: C 
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QUESTION 8: 
 
Management has asked Bob to post an introductory Welcome page when Notes users first open the Video 
application. In which one of the following places should Bob put the Welcome message? 
 
A. In a document named Welcome 
 
B. In the database About document 
C. In the database Using document 
D. In the first Page in the database design 
 
Answer: B 

 
QUESTION 9: 
 
Shirin plans to change the forms and view of a production database. She will make the changes locally 
and then update the application's design template with the changes. Which one of the following server 
tasks does the administrator run in order for the changes to take effect? 
 
A. DESIGN 
B. UPDALL 
C. REPLICA 
D. FIXUP - D 
 
Answer: A 

 
QUESTION 10: 
 
Ken would like to allow remote salespeople to replicate information from the videoinfo.nsf database to 
their laptops, so that the replications are fast and the database on each laptop isn't too big. Each 
salesperson should only replicate the information from their territory. Which one of the following does 
Ken need to do to configure this? 
 
A. Use a selective replication formula. 
B. Give the salespeople Reader access to the database. 
C. Give the SalesPeople group the [TerritoryOnly] role. 
D. Use AuthorName fields to limit access to information. 
 
Answer: A 

 
QUESTION 11: 
 
Kristin wants to build an action which exits the Video form. Which one of the following will accomplish 
this? 
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A. @Command([Back]) 
B. @Command([FileExit]) 
C. @Command([GoToView]) 
D. @Command([FileCloseWindow]) 
 
Answer: D 

 
QUESTION 12: 
 
Kristin is creating a page in the Videos application. Which one of the following statements about pages is 
NOT true? 
 
A. Pages are design elements. 
B. Pages can be full-text indexed. 
C. Pages can be referenced by outlines or frames. 
D. Pages can include text, graphics, applets and links. 
 
Answer: B 

 
QUESTION 13: 
 
Yuri created a formula for a button. The code is supposed to set the value of an existing field called Title. 
He used the following formula: 
"" 
After the formula runs, the Title field is null. Which one of the following is the reason? 
 
A. The value of one field cannot be set from the value in another field. 
B. The text string in the formula is set to null. Thus Notes cannot validate the formula. 
C. When setting the value of a field, the formula must be in the field's Input Validation event. 
D. The formula does not specify that Title is an existing field. Thus it is interpreted as a temporary variable. 
 
Answer: D 

 
QUESTION 14: 
 
Which one of the following should Maria do to display the release date in a text column? 
 
A. Use the number and time format options. 
B. Use the @DateToText function to convert time to text. 
C. Concatenate the data types using mathematical operators. 
D. Use the @Text function to convert time and number data text in text columns. 
 
Answer: D 

 
QUESTION 15: 
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Robert does not want Authors in the Video database's ACL to be able to edit certain fields in documents 
they created. Which one of the following can he do to accomplish this? 
 
A. Set field security options to: Must have at least Editor access to use. 
B. Use a Readers field on the form to prevent access to existing documents. 
C. Use an Authors field on the form to prevent access to existing documents. 
D. Create a standard section on the form and put the restricted fields in the section. 
 
Answer: A 

 
QUESTION 16: 
 
When a user clicks a link in the left frame of the Review application, the linked data displays in the frame 
on the right. Which one of the following did Kristin do to allow this to happen? 
 
A. Entered the name of the target frame in Hotspot properties. 
B. Entered the name of the target frame in Frameset properties. 
C. Entered the position of the target frame in Frame properties. 
D. Entered the position of the target frame in Hotspot properties. 
 
Answer: A 

 
QUESTION 17: 
 
Tommy has created a Sales view in his sales.nsf database. Tommy wants negative numbers in the Sales 
Number column in the view to be parenthesis. Which one of the following should Tommy do? 
 
A. Select the Parenthesis when negative value in the View Properties box. 
B. Select the Parenthesis when negative value in the Column Properties box. 
C. Use the @function @Negative to set this in the column formula in the view. 
D. Use a formula to format the value in the field on the form that will be displaying in the view. 
 
Answer: B 

 
QUESTION 18: 
 
Jackie wants to remove an action hotspot but leave the image on his Video form. In which one of the 
following ways can he do this? 
 
A. Delete the image and reinsert it into the form. 
B. Select the hotspot and choose the Hotspot>Remove Hotspot menu command. 
C. Highlight the hotspot and choose the Design>Hotspot>Remove menu command. 
D. Select the hotspot and choose the Design>Hotspot>Remove Hotspot menu command. 
 
Answer: B 
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QUESTION 19: 
 
Norma has a form action that will allow users to create comments to the existing document. When Norma 
views the form in her Web Browser, she sees the action, but when she opens the form in her Notes client 
she cannot see the action. Which one of the following should she do to correct the problem? 
 
A. Delete the old action and create a new one on the form. 
B. Make sure the comments form is available for Notes Client use. 
C. Make the action a shared action and disable the Hide-when settings for "Web Browsers". 
D. Check the action Hide-when settings to make sure the action is available for "Notes 4.6 or later". 
 
Answer: D 

 
QUESTION 20: 
 
Nadia would like to position overlapping blocks of content on a form in the Video application. She wants 
the flexibility to control the placement, size and content of the information. Which one of the following 
should Nadia use when creating her form? 
 
A. Layers 
B. Subforms 
C. Framesets 
D. Style Sheets 
 
Answer: A 

 
QUESTION 21: 
 
Which one of the following formulas does Cheng use to change the value of the ReleaseDate field to 
today's date? 
 
A. ReleaseDate := @Today 
B. TEMP ReleaseDate := @Today 
C. FIELD ReleaseDate := @Today 
 
Answer: C 

 
QUESTION 22: 
 
A Response document created by Hans appears as "Not Categorized" in a database view. It was intended 
to appear in the view as a response to a review document. Which one of the following could have caused 
the problem? 
 
A. Form Type is set to Document. 
B. Form Type is set to Response to Response. 
C. View Selection formula is set to: SELECT Form = "Review" & @lsresponsedoc. 
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D. View Selection formula is set to: SELECT Form = "Review" | @AllDescendants. 
 
Answer: A 

 
QUESTION 23: 
 
Derek has created a view in the products.nsf database. Derek wants the Markup column in the view to 
display the selling price of the item minus the cost. He wants this value to display in currency. Which one 
of the following should Derek do? 
 
A. Use the @function @Currency in the column formula in the view. 
B. Select currency on the Numbers tab in the View Properties box. 
C. Select currency on the Numbers tab in the Column Properties box. 
D. Select currency on the Numbers tab in the Field Properties box of the cost field. 
 
Answer: C 

 
QUESTION 24: 
 
Which one of the following accurately describes field names? 
 
A. They must be unique in a database. 
B. They must include text and a number. 
C. They can only be used once in a view. 
D. They can only be used once on each form. 
 
Answer: D 

 
QUESTION 25: 
 
Cindy has created a private agent. She wants her colleagues to be able to use it. Which one of the 
following should she do? 
 
A. Change the agent property to shared. 
B. Copy the agent to a Domino 6 server. 
C. Change the agent property to Shared Code. 
D. Delete the agent. She must create it again as a shared agent. 
 
Answer: A 

 
QUESTION 26: 
 
Jim created a field hint for the Address field. Users tell him this text disappears when they click in the 
Address field. Which one of the following is the most likely reason? 
 
A. The Address field is computed. 
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B. Jim should have used a text popup. 
C. Jim stored the field hint in the database. 
D. Field hints only display when the user has not clicked in the field. 
 
Answer: D 

 
QUESTION 27: 
 
Furio is designing some graphic images to use on Hotspot actions in the Video application forms. The 
Hotspots will be used in all of the forms in the application. Which one of the following lists the types of 
graphic images Furio can create and use as image resources? 
 
A. .GIF and .JPG only 
B. .BMP and .JPG only 
C. .BMP, .GIF and .JPG only 
D. .BMP, .GIF, .JPG and .TIFF only 
 
Answer: C 

 
QUESTION 28: 
 
Cheng wants to write a view selection statement to include documents created with the Review form and 
any responses. Which one of the following statements should Cheng write? 
C. SELECT Form = "Review" | @AllDescendants 
D. SELECT Form = "Review" & @AllDescendants 
 
 
Answer: C 

 
QUESTION 29: 
 
Kristin wants to create an action in the Titles view. The code in the action is: 
"" 
When the user clicks the action, which one of the following will be affected? 
 
A. The Video form 
B. All selected documents 
C. All documents in the database 
D. Documents defined by the selection formula in the view 
 
Answer: B 

 
QUESTION 30: 
 
Helga is working with a multi-value field that has numeric values in a list. She would like to apply a 
formula to each item in the list, returning a new list. Which one of the following @Functions can she use 
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to accomplish this with one line of code? 
 
A. @Transform 
B. @ListProcess 
C. @ProcessList 
D. @ListEvaluate 
 
Answer: A 

 
QUESTION 31: 
 
Review the formula below, assuming that the Author field contains the following: 
Richard Clarke/Meadowlands/ACME 
Which one of the following will the formula produce? 
 
A. Clarke 
B. Richard 
C. Meadowlands 
D. Richard Clarke 
 
Answer: B 

 
QUESTION 32: 
 
Maria coded "Alpha, Beta, Gamma" as a list in a Notes formula. Which one of the following indicates the 
syntax entered? 
 
A. "Alpha", "Beta", "Gamma" 
 
B. "Alpha"& "Beta"& "Gamma" 
D. "Alpha": "Beta": "Gamma" 
 
Answer: D 

 
QUESTION 33: 
 
Which one of the following formulas would find the first word (all characters before the first space) in a 
string field called Name? 
 
A. @Left(Name) 
 
Answer: A 

 
QUESTION 34: 
 
Which one of the following should Cathy use to sort a list? 



190-610 

Actualtests.com - The Power of Knowing 

 
A. @Sort 
B. @Sortlist 
C. @DataSort 
D. @ListOrder 
 
Answer: A 

 
QUESTION 35: 
 
When Robert created a Response form, he set the "Formulas inherit values from selected document" 
option on the form properties. The field name on the Review form is the same as the field name on the 
inheriting form. However, the form does not inherit any data. Which one of the following most likely 
caused this problem? 
 
A. He failed to specify the form type. 
B. The inheriting form is not a Response form. 
C. He specified the same field names on both forms. 
D. He failed to provide inheritance formulas for each field. 
 
Answer: D 

 
QUESTION 36: 
 
The Video application ACL supports 3 types of users: 
1. Users who can only view information in the application. 
2. Users who can view, enter and edit the information they have entered in the application. 
3. Users who can view and modify any document in the application. 
Cyd created groups in the Directory to hold the names of the different user types: 
1. Video Viewers 
 
2. Video Creators 
3. Video Modifiers 
Which one of the following should Cyd do to prevent the access by users who are not members in the 
groups listed above? 
 
A. Enable the "Group Access Only" setting on the database ACL. 
B. Enable the "Database Group Access Only" field in the Server document. 
C. Add an entry "No Access" to the database ACL and assign it "No Access". 
D. Set the "-Default-" entry to "No Access" in the and make it unspecified type. 
 
Answer: D 

 
QUESTION 37: 
 
Ted, a user of the Videos application, is unable to create a video description. Kristin, the application 
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administrator, surveys the ACL and discovers that Ted is a member of two groups in the ACL. Which 
one of the following describes the effective rights Ted has to the application? 
 
A. Default access 
B. The lower of the two groups 
C. The higher of the two groups 
D. No access (overlapping groups are not permitted) 
 
Answer: C 

 
QUESTION 38: 
 
Which one of the following statements about an Authors field is true? 
 
A. It can only contain one name. 
B. Users listed in the field can also read the document. 
C. It must be computed using @Author as the default formula. 
D. Users listed in the field are allowed to compose documents using that form. 
 
Answer: B 

 
QUESTION 39: 
 
Ted is in a group that has Author access in the Review application's ACL. However, he cannot edit a 
review he created. Which one of the following is the most likely reason? 
 
A. Authors can only create documents. 
B. He must have Editor or higher access to modify documents. 
C. The developer neglected to include an Authors field to the Review form. 
D. The developer neglected to select the "modify documents" option in the ACL. 
 
Answer: C 

 
QUESTION 40: 
 
Which one of the following describes who will be able to see an existing document that contains a 
Readers field? 
 
A. Only those people listed in the access list 
B. Anyone listed as a Reader or above in the ACL 
C. Only those people listed in the Readers field 
D. Anyone listed as a Reader or above in the ACL who is also listed in the Readers field 
 
Answer: D 
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QUESTION 41: 
 
Eduardo chose Native OS style (Use native control) when he created an editable text filed on a form. In 
which one of the following ways will the field appear to Notes users? 
 
A. Fixed-size outlined rectangle. 
B. Blank space marked off by red brackets. 
C. Blank space marked off by black brackets. 
D. The field will not appear to Notes users. It will only be visible to web users. 
 
Answer: A 

 
QUESTION 42: 
 
Karen has posted a template, "newvideo.ntf" for video application on the development server. Denise 
wants to create a new video application using the new template. Which one of the following does Denise 
need to do? 
 
A. Find the "newvideo.nsf" template on the development server and make a new copy of it. 
B. Find the "newvideo.nsf" template on the development server and make a replica copy of it. 
C. Select File>Database>New, choose the development server as the template server, and choose the 
"newvideo.ntf" template. 
D. Select File>Database>New Copy, choose the development server as the template server, and choose the 
"newvideo.nsf" template. 
 
Answer: A 

 
QUESTION 43: 
 
Carmine has created a new design for her Video application. Carmine would like to post the design to 
the server and make it available so other databases can automatically inherit the design changes when 
the DESIGN server tasks runs. Which one of the following should Carmine to do make the new design 
available on the development server? 
 
A. Copy the database to the development server, and name it "newvideo.ntf" 
B. Copy the database to the development server, and name it"newvideo.nsf" 
C. Copy the database to the server, name it "newvideo.ntf" select "inherit design from master template" and 
give it a template name in the database Design properties. 
 
D. Copy the database to the development server, name it "newvideo.ntf" select "Database file is a master 
template" and give it a template name in the database Design properties. 
 
Answer: D 

 
QUESTION 44: 
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Jayne has asked her Domino server administrator to enable document locking on the server. Which one 
of the following must she do to enable it for her application? 
 
A. Enable the "Allow document locking" database property 
B. Create a view column for the locked document view icon. 
C. Add profile document to the database to manage the locked documents. 
D. Enable document locking at the view level for each view in the database. 
 
Answer: A 

 
QUESTION 45: 
 
Tony wants to create a duplicate of the Video application. He wants to keep a version of the data on the 
same server as the production application but does not want any new documents or document 
modifications to be replicated into his new database once he creates it. Which one of the following should 
Tony do to create his archive? 
 
A. Create a new copy of the database. 
B. Create a replica copy of the database. 
C. Use the Windows explorer to create a copy of the database file. 
D. Create a replica copy of the database and disable replication on the database properties. 
 
Answer: A 

 
QUESTION 46: 
 
Christopher is making a new database using the "NewVideo"Design Template that he plans to 
customize. He wants to make sure that his new application will not get future modifications to the 
"NewVideo"Design Template. Which one of the following should Christopher do to accomplish this? 
 
A. Create a blamk database and refresh the design of the new database using the "NewVideo"Design Template. 
B. Create the new database from the "NewVideo"Design Template and deselect "Inherit future design changes" 
in the New Database dialog box. 
C. Create the new database from the "NewVideo"Design Template and then open the database Design 
properties and select " Database is a master template" 
D. Create the new database from the "NewVideo"Design Template and then open the database Design 
properties and select " Database file is a master template" 
 
Answer: B 

 
QUESTION 47: 
 
Mitchell would like to create a replica of a database from ServA to ServerB, but only wants the 
 
documents that use Form 
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A. Which one of the following will allow him to accomplish this? 
 
A. Create a selective replication formula 
B. Create a replica stub, then run an agent to set security on the documents 
C. Schedule an agent on ServerB that deletes all documents created with other forms. 
D. Schedule an agent on ServerA that copies all documents created with other forms to another database, then 
deletes them 
 
Answer: A 

 
QUESTION 48: 
 
Shirin plans to change the forms and views of a production database. She will make the changes locally 
and then update the application's design template with the changes. Which one of the following server 
tasks does the administrator run in order for the changes to take effect? 
 
A. DESIGN 
B. UPDALL 
C. REPLICA 
D. FIXUP-D 
 
Answer: A 

 
QUESTION 49: 
 
Ken would like to allow remote salespeople to replicate information from the videoinfo.nsf database to 
their laptops, so that the replications are fast and the database on each laptop isn't too big. Each 
salesperson should only replicate the information from their territory. Which one of the following does 
Ken need to do to configure this? 
 
A. Use a selective replication formula. 
B. Give the salespeople Reader access to the database. 
C. Give the SalesPeople group the [TerritoryOnly]role. 
D. Use AuthorName fields to limit access to information. 
 
Answer: A 

 
QUESTION 50: 
 
Furio is designing some graphic images to use on Hotspot actions in the Video application forms. The 
Hotspots will be used in all of the forms in the application. Which one of the following lists the types of 
graphic images Furio can create and use as image resources? 
 
A. .GIF and .JPG only 
B. .BMP and .JPG only 
C. .BMP, .GIF and .JPG only 
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D. .BMP, .GIF, .JPG and .TIFF only 
 
Answer: C 

 
QUESTION 51: 
 
Which one of the following best describes the use of hidden column formulas? 
 
A. View can be hidden based on a formula. 
B. Hidden columns are not a supported feature. 
C. Table columns can be hidden based on a formula. 
D. View columns can be displayed or hidden based on a formula. 
 
Answer: D 

 
QUESTION 52: 
 
Bill wants to create a frameset in which the upper left frame only shows his company logo and has no 
other elements such as fields or hotspots. He has created an image resource for the logo in the database. 
Which one of the following is the best way Bill can place the image resource into the frame? 
 
A. Directory in the frame contents 
B. On a Page and put the Page in the frame contents 
C. On a Form and put the Form in the frame contents 
D. On a Layout region and put the Layout region in the frame contents 
 
Answer: B 

 
QUESTION 53: 
 
Olga wants to have one action on the video form that will give the options to Print,Save, and Exit the 
document when it is clicked. In which one of the following ways can she accomplish this? 
 
A. Use a cascaded action. 
B. Layer the actions in the Action menu. 
C. Use action buttons within an Outline control in a hidden frame to present "twisties" 
D. Use Hide/when formulas along with a database profile field setting to display "toolbars" of icons. 
 
Answer: A 

 
QUESTION 54: 
 
Yuri created a formula for a button. The code is supported to set the value of an existing field called 
Title.He used the following formula: 
After the formula runs, the Title field is null. Which one of the following is the reason? 
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A. The value of one field cannot be set from the value in another field. 
B. The text string in the formula is set to null. Thus Notes cannot validate the formula. 
C. When setting the value of a field, the formula must be in the fields input validation event. 
D. The formula does not specify that Title is an existing field. Thus it is interpreted as a temporary variable. 
 
 
Answer: D 

 
QUESTION 55: 
 
Hans is designing the Reviews application. The application will include two forms: Review and 
Response. In the view, the Response documents do not appear under the Review documents from which 
they were created. Which one of the following could cause this to happen? 
 
A. Inheritance in the Review from was disabled. 
B. Shared field values were enabled on both forms. 
C. Shared field values and field definitions were enabled 
D. Show Response documents in a hierarchy was not enabled. 
 
Answer: D 

 
QUESTION 56: 
 
To capture the date a document is created, Maria uses @Today in a formula. However, when she edits a 
document and saves it again, the changes from the creation to the current date. Which one of the 
following causes the date to change? 
 
A. The document was edited by another user. 
B. The formula was placed in a Computed field. 
C. She does not have the appropriate ACL access. 
D. The formula was placed in a Computed when Composed field. 
 
Answer: B 

 
QUESTION 57: 
 
Which one of the following types of actions can be used on unopened documents? 
 
A. Form action 
B. View action 
C. Hotspot action 
D. Database action 
 
Answer: B 

 



190-610 

Actualtests.com - The Power of Knowing 

QUESTION 58: 
 
Which one of the following formulas does Cheng use to change the value of the ReleaseDate field to 
today's date? 
 
Answer: C 

 
QUESTION 59: 
 
Derek has created a view in the sales.nsf database. Derek wants the Sales Value column in the view to be 
punctuated to display two decimal places. Which one of the following should Derek do? 
 
A. Use the @function@Decimal in the column formula in the view. 
B. Select decimal on the NumbersTab in the view Properties box. 
C. Select decimal on the Number tab in the Clolumn Properties box. 
D. Use the @function@Decimal to format the value in the field on the form that will be displaying in the view. 
 
Answer: C 

 
QUESTION 60: 
 
Nancy 
used a Rich Text field on a form to capture data. She would like to display the data in a view. Which one 
of the following should she do? 
 
A. Use @Text ToRichText 
B. Use a Rich Text lit field. 
C. Use @Text (fieldname) in the column formula 
D. Nothing Rich Text displays in views. 
 
Answer: C 

 
QUESTION 61: 
 
The Video form has a graphic Hotspot that opens the IMDB Web page. Which one of the following did 
Hillary do to create the hotspot? 
 
A. Highlighted the graphic, chose Create>Hotspot>Link Hotspot, and created a URL link. 
B. Highlighted the graphic, chose Create>Hotspot>Web Link and entered a URL into the dialog box. 
C. Highlighted the graphic, chose Create>Hotspot>URL Link and created a link to the IMDB application. 
D. Highlighted the graphic, chose Create>Hotspot>Link and created an action link and used a formula to open 
the URL of the IMDB Web page. 
 
Answer: A 
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QUESTION 62: 
 
Kristin wants to create an action in the Title view. The code in the action is: 
When the user clicks the action, which one of the following will be affected? 
 
A. The Video form 
B. All selected documents 
C. All documents in the database 
D. Documents defined by the selection formula in the view. 
 
Answer: B 

 
QUESTION 63: 
 
Lee wants to create an agent that only processes documents where the field "Type "has the 
value"Action". Which one of the following statements should Lee include in his agent? 
C. SLECT Type= "Action". 
 
Answer: C 

 
QUESTION 64: 
 
Robert does not want Authors in the Video database's ACL to be edit certain fields in documents they 
created .Which one of the following can he do to accomplish this? 
 
A. Set field security options to:Must have at least Editor access to use. 
B. Use a Readers field on the form to prevent access to existing documents. 
C. Use an Authors field on the form to prvent access to existing documents. 
D. Create a standard section on the form and put the restricted fields in the section. 
 
Answer: A 

 
QUESTION 65: 
 
When Eduardo tried to open a document in the Coming Attractions view, he got the following error 
message: 
In correct data type for operator or @Function: Text Expected. 
Which one of the following did he most do to cause this to happen? 
 
A. He entered text in a number field 
B. He neglected to place formula in a validation event. 
C. He neglected to place a formula in a transaction event. 
D. He combined a text field and a time field in a formula. 
 
Answer: D 
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QUESTION 66: 
 
Which one of the following agents would change the contents of the Type field to "Sci-Fi" in all 
documents that have "Richard Clark' in the Director field? 
 
Answer: C 

 
QUESTION 67: 
 
A Response document created by Hans appears as "Not Categorized" in a database view. It was 
intended to appear in the view as a response to a review document. Which one of the following could have 
 
caused the problem? 
 
A. Form Type is set to Document. 
B. Form Type is set to Response to Response. 
C. View Selection formula is set to:SELECT Form = "Review" & @Isresponsedoc. 
D. View Selection formula is set to: SELECT Form = 'Review" I @AllDescendants. 
 
Answer: A 

 
QUESTION 68: 
 
Mary would like to display a collapsed section on her video catalog form. She has created a section but 
when she displays the form in the Notes client the section always opens expanded. Which one of the 
following should Mary do to collapse the section? 
 
A. Nothing: sections always open expanded. 
B. Modify the section default properties to collapsed. 
C. Modify the form properties to display all sections collapsed. 
D. Modify the section Opened for Reading property to auto-collapse. 
 
Answer: D 
 
Explanation:  
Use sections to group and organize elements on a page or form. Sections work well to present large amounts of 
information in an uncluttered way. For example, if you have two different procedures on a page, and users only 
need to see one at a time, you can put each procedure into a collapsible section so that the users can expand 
only the section that they need. 
On the Expand/Collapse tab: 
Select options for showing the section expanded or collapsed depending on whether a document is being 
previewed, opened for reading, opened for editing, or printed. 
Select "Hide title when expanded" if users don't need to see the section title when the fields are displayed. 
Select "Show as text when not previewing" so that the user sees the section only when the document is being 
previewed. If the document is being printed or is opened for reading or editing, the user sees the text with no 
visible sign that the text is contained in a section. 
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QUESTION 69: 
 
Justice created an agent that only a few users should be able to use. Which one of the following should he 
do to prevent unauthorized users from using the agent? 
 
A. Select "All Readers and above' on the "Default access for viewing and running this agent" and enter users, 
groups or roles into the Agent Access field 
B. Select "All Readers and above' on the "Default access for viewing and running this agent" and select users, 
groups or roles into the Agent Access field 
C. Deselect "All Readers and above' on the "Default access for viewing and running this agent" and enter users, 
groups or roles into the Agent Access field 
D. Deselect "All Readers and above' on the "Default access for viewing and running this agent" and select 
users, groups or roles into the Agent Access field 
 
Answer: D 

 
QUESTION 70: 
 
Which one of the following best describes the places where a layer can be used? 
 
A. Form 
B. Page 
C. Subform 
D. All of the above 
 
Answer: D 

 
QUESTION 71: 
 
Bill has an author names field named All Editors that calculates a list of possible editors of the document 
based on values users have entered into another field. The list only contains users First and Last names, 
and only should be displayed to users who can edit the document. 
Which one of the following Hide-When formulas should Bill use to control the display of the field? 
 
Answer: C 

 
QUESTION 72: 
 
Danielle wants to capture everything from a Notes hierarchical name except for the common name. 
Which one of the following formulas will accomplish this? 
 
A. @ExcludeCommonName(User_Name),where User_Name is a field that contains the name value. 
D. Danielle cannot use the formulas above. She must parse the pieces of the name that she wants by using 
@Name and then containing them together. 
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Answer: C 

 
QUESTION 73: 
 
James needs to store a list of values in FieldA, and when the form is saved, he wants to sort the list 
before it is saved. Which one of the following input transaction formulas would accomplish this? 
 
A. @Sort 
B. @Sort(@ThisValue) 
C. @SortAscending(FieldA) 
D. @Sort("Ascending","FieldA") 
 
Answer: B 

 
QUESTION 74: 
 
Several @Functions can execute multiple statements. Which one of the following initializes a variable and 
can increment it during the operation? 
 
A. @Do 
B. @For 
C. @while 
D. @DoWhile 
 
Answer: B 

 
QUESTION 75: 
 
Cindy wants to set up third-party tools so she can access them via Designer. Which one of the following 
should Cindy do? 
 
A. File>Import 
B. Tools>Import 
C. Tools>Add Tool 
D. Shared Resources>Third Party Tool 
 
Answer: B 

 
QUESTION 76: 
 
In the video form, the OrderDate field (which shows the video can be ordered) is calculated based on the 
Date field (which displays the release date). The order date is 30 days prior to the release date. Which one 
of the following formulas will calculate the OrderDate value? 
 
A. @Number(Date) - 30 



190-610 

Actualtests.com - The Power of Knowing 

 
Answer: C 

 
QUESTION 77: 
 
Which one of the following can be printed from the Domino Designer IDE? 
 
A. Current selection 
B. Alternative language 
C. Only LotusScript language 
D. Other objects Alternative language 
 
Answer: A 

 
QUESTION 78: 
 
Maria coded "Alpha, Beta Gamma" as a list in a Notes Formula. Which one of the following indicates 
 
the syntax entered? 
 
A. "Alpha" "Beta" "Gamma" 
B. "Alpha" & "Beta" &"Gamma" 
C. "Alpha" "Beta" "Gamma" 
D. "Alpha": "Beta": "Gamma" 
 
Answer: D 

 
QUESTION 79: 
 
Jim, a Domino programmer, wants to determine the number of working days in a year. Which one of the 
following @functions should he use? 
 
A. @Days 
B. @holidays 
C. @WorkedDays 
D. @BusinessDays 
 
Answer: D 

 
QUESTION 80: 
 
The video application ACL supports 3 types of users: 
1. Users who can only view information in the application 
2. Users who can view, enter, and edit the information they have entered in the application. 
3. Users who can view and modify any document in the application 
Cyd created groups in the Directory to hold the names of the different user types: 
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1. Video Viewers 
2. Video Creators 
3. Video Modifiers 
Which one of the following should CYD DO TO PREVENT THE ACCESS BY USERS WHO ARE NOT 
MEMBERS IN THE GROUPS LISTED ABOVE? 
 
A. Enable the "Group Access Only" setting on the database ACL. 
B. Enable the "Database Group Access Only" field in the Server document. 
C. Add an entry "No Access" to the database ACL and assign it "No Access" 
D. Set the "-Default-"entry to "No Access"in the and make it unspecified type. 
 
Answer: D 

 
QUESTION 81: 
 
John has created a database library. Librarians are responsible for adding new information to the 
database library. Which one of the following is the minimum level of access he can grant the librarians of 
the database library? 
 
A. Reader 
B. Author 
 
C. Manager 
D. Designer 
 
Answer: B 

 
QUESTION 82: 
 
Which one of the following statements about Readers fields id True? 
 
A. A Readers field may be computed or editable. 
B. Readers field only affected those people who have reader access. 
C. A form may contain several Readers fields, each of which affects who can read different sections of a form. 
D. A users listed in an Author field must also be listed in a field with Readers data type in order to read a 
document. 
 
Answer: A 

 
QUESTION 83: 
 
Ted, a user of the Videos application, is unable to create a video description. Kristin, the application 
administrator, surveys the ACL and discovers that Ted is a member of two groups in the ACL. Which 
one of the following dscribes the effective rights Ted has to the application? 
 
A. Default access 
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B. The lower of the two groups 
C. The higer of the two groups 
D. No access(overlapping groups are not permitted) 
 
Answer: A 

 
QUESTION 84: 
 
The video application ACL supports 3 types of users: 
2. Users who can only view information in the application 
3. Users who can view, enter, and edit the information they have entered in the application. 
4. Users who can view and modify any document in the application 
Cyd created groups in the Directory to hold the names of the different user types: 
1. Video Viewers 
2. Video Creators 
3. Video Modifiers 
Cyd adds the three groups and wants to control the access of different users. In which one of the 
following ways should he assign access levels? 
 
A. 1.Video Viewers =Reader 
2.Video Creators = Author 
3.Video Modifiers = Editor 
B. 1.Video Viewers = Reader 
2.Video Creators =Editor 
3.Video Modifiers = Manager 
 
C. 1.Video Viewers = Reader 
2.Video Creators = Editor 
3.Video Modifiers = Editor 
D. 1.Video Viewers =Reader 
2.Video Creators = Depositor 
3.Video Modifiers = Designer 
 
Answer: A 

 
QUESTION 85: 
 
Sergey is listed in the Authors field of a document that has no Readers field. He 
also has Author access to the database where the document resides through the 
ACL. Stan has Editor access to the database and Martha has Reader access to 
the database. Who can read and/or edit the document? 
 
A. Only Stan can read and edit the document. 
B. Everyone can read and edit the document, but only Sergey can edit it. 
C. No one can read the document because there is no Readers field. 
D. Everyone can read the document but only Sergey and Stan can edit it. 
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Answer: D 
 
Explanation:  
Absence of a Readers field means anyone with at 
least Readers access in the database ACL can read the document, and this 
includes Martha. Sergey is in the Authors field, which allows him to edit the 
document. Unlike Stan, Sergey has only Author access in the ACL, and must 
be listed in an Authors field before he can edit a document. Stan, through his 
Editor access in the ACL, can edit any document. A is incorrect because in 
the absence of a Readers field, anyone who has access to the database can 
read the document. B is incorrect because Stan has Editor access through the 
database ACL. C is incorrect because in the absence of a Readers field, anyone 
who has access to the database can read the document. 

 
QUESTION 86: 
 
Greg wants to edit a form and he does not want other developers to work on it 
while he has it open. Does he need to explicitly lock the form? 
 
A. Yes. Another developer with higher access could override Greg¡¦s access and work on the form. 
B. No. The form is temporarily locked while it is being edited. 
C. No. The form is automatically locked while it is being edited and will remain locked until Greg unlocks it. 
D. Yes. Explicit locking prevents people from creating documents from the old form until the new one is 
finished and unlocked. 
 
Answer: B 
 
 
Explanation:  
ocking prevents anyone, regardless of access, from 
editing a design element. The design element is automatically locked as soon 
lock is removed. It is important to remember that temporary locking does 
not require explicit unlocking. A is incorrect because locking prevents anyone, 
even users with Manager access, from editing that same design element. 
C is incorrect because temporary locking does not require explicit unlocking. 
D is incorrect because users will still be able to create documents using the 
old form until the new design changes to the form are saved. 

 
QUESTION 87: 
 
Buddy is a developer with Manager access, and he has created a server agent 
that he wants to run with Manager access. How can he provide the agent with 
this access? 
 
A. Have an administrator sign the database. 
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B. Sign the agent. 
C. Edit and re-save the agent. 
D. All of the above. 
 
Answer: D 
 
Explanation:  
The designer is allowed to sign one or more agents 
at the same time by either clicking on the action button found in the agents 
list or through the menu that appears after right-clicking on the agent in the 
list. A designer can open and save an agent, thus signing it with his or her 
own access. The designer must have the same access rights as desired for the 
agent. Administrators can sign individual design elements or the entire database 
with an administrative ID file. 

 
QUESTION 88: 
 
Tedd has a view with three sortable columns: Name, Username, and ID #. He 
wants to make the background color of the Username column light blue so he 
can differentiate it from the Name and ID # columns at a glance. After saving this 
design change, Tedd looks at the view again and sees the light blue background 
in both the Username and ID # columns. What went wrong? 
 
A. Tedd needs to add a hidden column before the Username column and set its background color to light blue. 
B. Tedd must have accidentally set the background color of the ID # column and needs to restore the 
background property through the column¡¦s Text tab. 
C. Tedd should add a hidden column before and after the Username column. The left column should be set to 
the light blue background and the right column should be set to the default white background. 
D. Tedd has to change the background color to Transparent through the view¡¦s ¡*Style¡ tab. 
 
 
Answer: C 
 
Explanation:  
Tedd should add a hidden column before and after 
the Username column. The left column should be set to the light blue background 
and the right column should be set to the default white background. 
A is incorrect because setting only the hidden column to the left of the 
Username column caused Tedd¡¦s problem in the first place¡Xevery column to 
the right of the hidden column is light blue. B is incorrect because for the 
background ID # column to be light blue, there must be a hidden column to 
its left set to light blue. D is incorrect because the Transparent setting refers 
to the rows of a view, not its columns. 

 
QUESTION 89: 
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Doris has just made a modification to a .gif file of a logo that is shared by seven 
databases. She decides to save the file into each database. Is this the most efficient 
way to update the logo on each database? 
 
A. No. If the logo is a shared file resource, she can go to each database and refresh the file through the files 
work pane. 
B. Yes. Although it is work-intensive, it is the best way to make sure the newly modified file is used by each 
database. 
C. No. If the logo is on subforms, she can select all the subforms and change the logo on each of them at the 
same time. 
D. No. She can select all design elements that contain the logo and change the logo on each of them at the same 
time. 
 
Answer: A 
 
Explanation:  
This method is the least labor intensive and is still 
accurate. The file¡¦s work pane shows a refresh icon if a file has been modified 
but has not been changed in the database. Also, the File Resources property 
box has the Needs Refresh check box checked if a file has been modified. B 
is incorrect because this method is more prone to human error¡XDoris may 
forget to save a form with the new logo change or even copy the wrong logo 
into a form. By using a shared file resource, Doris has the Needs Refresh 
check box to remind her to update the logo change. C is incorrect because a 
designer can select design elements of only one database at a time to modify. 
Also, modification is limited to setting design properties¡Xsuch as preventing 
replication from changing a design element¡Xand does not affect 
anything within the element¡Xsuch as color, fields, or images. D is incorrect 
because the Transparent setting is used for background images. 

 
QUESTION 90: 
 
Paula has opened a document in InsuranceForms.nsf, a Notes database that 
 
resides on the INSHQ server. The picklists in the document are all set to perform 
lookups in another database, called Keywords.nsf, which also resides on the 
INSHQ server. After choosing a state from a picklist, Paula runs into trouble 
when she sees nothing but a blank list for the county picklist. Why has this happened? 
 
A. The INSHQ server is down. 
B. Paula does not have Reader access to the view used in the picklist lookup. 
C. Instead of explicitly listing INSHQ as the server name in the @DbLookup function, double quotes (¡*¡) were 
used instead. 
D. Paula¡¦s document was not in edit mode. 
 
Answer: C 
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Explanation:  
Even though both databases reside on the same 
server, the server name must be included in the @DbLookup. Double quotes (¡*¡) 
indicate that the lookup is to be used on a local database. A is incorrect 
because if the server was down, Paula would not have been able to use any 
other picklists, let alone open a document in the first place. B is incorrect 
because if Paula did not have Read access to a view, the picklist would display 
an error message to that effect. D is incorrect because the document would 
have to be in edit mode for Paula to use the picklist fields. 

 
QUESTION 91: 
 
Jeanmarie wants to show whether or not a document is locked. What @Function 
should she use? 
 
A. @IsDocLock([LOCK]) 
B. @DocLock([STATUS]) 
C. @DocLock([LOCKINGENABLED]) 
D. @IsDocLock([STATUS]) 
 
Answer: B 
 
Explanation:  
@DocLock([STATUS]) provides a list of the users who 
have locked the document, or a null value if the document is unlocked. A is 
incorrect because there is no such function as @IsDocLock. C is incorrect 
because @DocLock([LOCKINGENABLED]) indicates whether or not the current database 
has document locking enabled. D is incorrect because there is no such 
function as @IsDocLock. 

 
QUESTION 92: 
 
Lena has to change the name of a view that also has an alias. There is extensive 
code that refers to the old name of the view as well as its alias, and because the 
view is very important to its users, Lena must make the change as quickly as 
 
possible. What should she do? 
 
A. Lena should copy the old view name to the left of the current alias in the view¡¦s alias box, using a vertical 
bar ( | ) as a separator. 
B. Lena should change the code so that it refers to only the view¡¦s alias. 
C. Lena should copy the old view name to the right of the new view name with a backslash ( \ ) as a separator. 
D. Lena can do nothing in the span of time she has to make a change in the view. 
 
Answer: A 
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Explanation:  
Code referring to either the old view name or the 
current alias brings up the correct view: NewViewName | OldViewName | 
Alias. B is incorrect because Lena would have to spend time tracking down 
the code that refers to the old view name and she does not have that time to 
spare. C is incorrect because it would create cascading views of the new view 
name and the old view name. D is incorrect because it would take very little 
time to add the new view name at the head of the original view name, then 
separate the new and old view names with a |. 

 
QUESTION 93: 
 
To add a tool to Domino, 
 
A. select Actions, Add Tool, then enter the name of the tool. Select the submenu under which it falls, then 
choose the tool action and tool location. Click OK. 
B. select Tools, Add Tool, Tool submenu, then enter the name of the tool. 
 
A. Choose the tool action and tool location. Click OK. 
B. select Tools, Add Tool, then enter the name of the tool. Select the tool action and tool location. Click OK. 
C. select Tools, Submenu, Add Tool, then enter the name of the tool. Choose the tool action and tool location. 
Click OK. 
 
Answer: C 
 
Explanation:  
Select Tools, Add Tool, then enter the name of the 
tool. Select the tool action and tool location. Click OK. A is incorrect because 
there is no submenu to select after choosing the name of the tool. B is incorrect 
because there is no submenu to select after the Add Tool step. D is incorrect 
because there is no submenu to select after the Select Tools step. 

 
QUESTION 94: 
 
John has a database that has replicas on Server1, Server2, and Server3. Users 
have limited access to the database on Server1, which is the source server. 
However, some Depositor-Only users are able to see the documents on the replica 
located on Server2, although they can¡¦t see them on the replicas located on 
 
Server1 and Server3. What could be causing this? 
 
A. The ACL of the replica on Server2 is different from those on Server1 and Server3. 
B. Server2 and Server3 have different access to the database than Server1 has. 
C. The users hacked into the database replica on Server2. 
D. Nothing is wrong. Depositor-Only access allows users to see documents by default. 
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Answer: A 
 
Explanation:  
John needs to select Enforce Consistent ACL in the 
Advanced section of the database ACL to keep the same ACL settings in all 
database replicas. He must also make sure Server1 has Manager access to all the 
replicas before selecting the enforcement, otherwise no change will be made. B 
is incorrect because user access is being affected. Even if a server had Reader 
access to the database, Depositor-Only users should not be able to see documents 
in the database. The only way these users could see documents is if they 
had Reader access or higher in the database ACL, although if they had at least 
Author access they would be able to read their own documents. C is incorrect 
because Lotus Notes¡¦ strong security (user roles, Authors and Readers fields, 
access control lists, and so on) deters unauthorized users. It is not impossible, 
but highly unlikely, that the users could have hacked into the database. D is 
incorrect because Depositor-Only access allows users to create and save a document, 
but these users cannot see their own or other users¡¦ documents. 

 
QUESTION 95: 
 
How do you enable Auto-Complete? 
 
A. Auto-Complete is enabled by default. 
B. Select the Preferences, User Preference menu, then click on Basics to display the Auto-Complete options. 
C. Select the options tab of the Programmer¡¦s pane, then enable the Auto- Complete options for LotusScript, 
HTML, and @Formulas. 
D. Select the Options tab of the Programmer¡¦s pane, then enable the Auto-Complete options for LotusScript 
and @Formulas. HTML is not included because it is not a programming language. 
 
Answer: A 
 
Explanation:  
Auto-Complete is enabled by default. B is incorrect 
because Auto-Complete cannot be set through the Preferences, User 
Preference menu. C is incorrect because Auto-Complete is already enabled 
for LotusScript, HTML, and @Formulas, and Auto-Complete cannot be set 
through the Programmers pane. D is incorrect because Auto-Complete is 
already enabled for LotusScript and @Formulas, and includes HTML. Also, 
Auto-Complete cannot be set through the programmers pane. 

 
QUESTION 96: 
 
Buddy has an agent he wants to run with Manager access. How can he provide 
the agent with this access? 
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A. Have an administrator sign the database. 
B. Sign the agent. 
C. Edit and re-save the agent. 
D. All of the above. 
 
Answer: D 
 
Explanation:  
The subaction can be dragged in between subactions 
Level 1 and Level 3. A caveat to remember about subactions is that the 
arrow. A is incorrect because a subaction can be replaced. B is incorrect 
because subactions can be sorted in order. C is incorrect because a subaction 
can be dragged into position without replacing the subaction already there. 
Instead, the original subaction moves down the action pane. 

 
QUESTION 97: 
 
Betty would like a set of ¡*Contact Us¡ icons to appear in various events: a regular 
picture of a pencil if there is no event occurring, a larger picture of the pencil 
if the mouse moves over it, and a picture of the pencil writing if the mouse 
clicks it. What is the best way to create and store the images? 
 
A. Name each image and store them individually in Image Resources. 
B. Save each image with .ANI so that they will change depending on the mouse events. 
C. Define an image well in the Basics tab of the Image Resource properties. 
D. Embed the images in the form and use hide/when formulas to switch between images according to mouse 
events. 
 
Answer: D 
 
Explanation:  
The error can be caused by changing the subform 
name¡Xthe insert subform formula is still searching for SubformNew, even 
though that subform may have another name. This problem can be corrected 
by either correcting the insert subform formula to load the subform¡¦s new 
name, or changing the subform¡¦s name back to SubformNew. The error can 
also be caused by deleting the subform¡Xthe insert subform is still searching 
for SubformNew. This problem can be corrected by either correcting the 
insert subform forumla to load another subform, or creating a new subform 
with the name SubformNew. A is incorrect because B is also a cause of the 
error. B is incorrect because A is also a cause of the error. C is incorrect 
because the error message would report an access error, not a loading error. 

 
QUESTION 98: 
 
Gary wants to provide expandable and collapsible rows in a table he has created. 
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What should he do? 
 
A. Select Show Only One Row at a Time in the Table Rows tab in the Tables property box and then check 
Expand/Collapse Rows. 
B. Select Show Only One Row at a Time in the Table Rows tab in the Tables property box and then check 
Users Pick Row via Tab Buttons. 
C. Select only Show Only One Row at a Time in the Table Rows tab in the Tables property box. 
D. Select Show Only One Row at a Time in the Table Rows tab in the Tables property box, then check Users 
Pick Row via Captions. 
 
Answer: D 
 
Explanation:  
Rather than clicking on tabs, users can click on captions 
for each row to reveal data by expanding the row. Clicking on the caption 
or the open/close icon to the far right of the caption closes the row. 
Through the properties box, developers can also determine the label, wording, 
font, size, style, and color of the captions. A is incorrect because there is 
no Expand/Collapse Rows check box in the Table rows property. B is incorrect 
because enabling users to pick tab buttons in a table simply allows them 
to click on a tab in the table to bring the desired row forward. C is incorrect 
because enabling Show Only One Row at a Time is the first of the two steps 
needed to create expandable and collapsible rows. 

 
QUESTION 99: 
 
Jean wants to show indented response documents beneath their parent documents. 
The first column is a Responses Only column that displays the name of 
about the response document. However, none of the response documents are 
displaying any information from the third column. Why? 
 
A. Jean should make the third column a ¡*Responses Only¡ column to make the data visible. 
B. Jean should include the information on the response documents in the ¡*Responses Only¡ column and delete 
the third column. 
C. Jean does not have the Show Response Documents in a Hierarchy view property checked. 
D. Jean does not have the Extend Last Column to Window Width view property checked, which is preventing 
the third column from being seen. 
 
Answer: B 
 
Explanation:  
The Responses column should be created to the left 
of the column where the response documents are to be indented. This column 
 
must have Show Responses Only selected in its column properties. Jean 
has already accomplished this part. However, it must be noted that on the 
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row where a response document appears, columns to the right of the 
not appear in the Response Document row. Any data concerning the 
response document must be placed in the first column. A is incorrect because 
with or without the third column being enabled to Responses Only, it will 
still not be visible because response data in columns to the right of the 
Responses Only column does not appear. Jean should place the information 
in the first column. C is incorrect because Notes views default to Show 
Response Documents in a Hierarchy. D is incorrect because response data in 
columns to the right of the Responses Only column does not appear. 

 
QUESTION 100: 
 
To receive design changes from Server1, the database replica on Server2 must 
give Server1 at least 
 
A. manager access, and the database replica on Server1 must give Server2 at least Reader access. 
B. designer access, and the database replica on Server1 must give Server2 at least Editor access. 
C. designer access, and the database replica on Server1 must give Server2 at least Reader access. 
D. editor access, and the database replica on Server1 must give Server2 at least Editor access. 
 
Answer: C 
 
Explanation:  
The source server, Server1, needs at least Designer 
access over all the design elements in the replicas. A is incorrect because 
Designer access is the least access needed for design changes. If Server1 were 
to control both ACL and designer changes, it would require Manager access. 
B is incorrect because the least access Server2 requires to pull design changes 
from Server1 is Reader. If Server2 were to add new documents and modify 
existing ones, it would require at least Editor access. D is incorrect because 
Editor access does not give Server1 control over the design elements. 

 
QUESTION 101: 
 
Lynne has Author access to a database, but when she tries to create a document 
from a form that has no Authors field, she gets an error: You are not authorized 
to perform this operation. What is causing the error? 
 
A. There are no Authors fields on the form to provide access. 
B. Lynne needs Editor access to create the document. 
C. Lynne is not included under Who Can Create Documents with This Form. 
D. Lynne is not included under Default Read Access for Document Created with this Form. 
 
Answer: C 
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Explanation:  
Either All Authors and Above has been deselected 
on the form¡¦s Security tab or Lynne has not been selected in the list of 
authors. A is incorrect because if a document has no Authors field, anyone 
with at least Editor access to the database can edit the document. If the user 
has at least Author access, he or she can edit his or her own documents. B is 
incorrect because Author access enables users to create documents. D is 
incorrect because Default Read Access for Document Created with this 
Form is used with Read access to the document, not Edit access. 

 
QUESTION 102: 
 
A traveling department manager wants to take a copy of Saleries.nsf on his laptop. 
Because this database contains sensitive information, Khalid needs to 
restrict access. What should he do? 
 
A. Encrypt the database on the server with the server ID to restrict access. 
B. Copy the database to the manager¡¦s laptop, then encrypt the database so that only the manager can access it. 
C. Copy the database to the manager¡¦s laptop, then restrict the access through the ACL. 
D. Nothing can be done because encryption cannot prevent access to API programs. 
 
Answer: B 
 
Explanation:  
Copy the database to the manager¡¦s laptop, then 
encrypt the database so that only the manager can access it. A is incorrect 
because only administrators with the server ID will be able to read the database. 
C is incorrect because ACL settings do not restrict access to local databases. 
One example is that a local database could be copied without its ACL 
settings, thus allowing anyone to read the database. D is incorrect because if 
an encrypted database is copied, it remains encrypted, even from API programs. 

 
QUESTION 103: 
 
Some users in Sanjay¡¦s company have been changing shared views on a database 
he maintains, and some have even changed the logo images on various 
forms. What steps should Sanjay take to prevent these users from changing the 
database design? 
 
A. Hide the database design in both the production database and the template. 
B. Hide the database design in the production database only. 
C. Hide the database design in the production database and remove Designer or higher access from the users in 
the ACL. 
D. Remove Designer or higher access from the users in the ACL. 
 
Answer: C 
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Explanation:  
 
Hiding the database design and preventing users 
from replacing the design helps safeguard the database design. A is incorrect 
because hiding the template design would disable the design operations and 
hide all formulas and scripts. B is incorrect because although the design is 
hidden, users with designer access or above can still replace the database 
design. Higher access from users must be removed as well. D is incorrect 
the design prevents copying. 

 
QUESTION 104: 
 
Terry wants to create a validation formula that is portable to any field. He 
should use 
 
Answer: D 
 
Explanation:  
@ThisValue returns the value of a field without 
requiring a field name. A is incorrect because @GetField requires a field name 
for its parameter. B is incorrect because @ThisName returns the name of the 
current field. C is incorrect because @Command([EditGotoField]) places the cursor 
in a predefined field of a document in edit mode. 

 
QUESTION 105: 
 
What is true about document locking? 
 
A. Document locking prevents replication of conflicts. 
B. Users with Editor access or higher can lock documents. 
C. Only the user who locks a document can unlock it. 
D. A and C. 
 
Answer: A 
 
Explanation:  
Other users with the same rights to a document 
cannot edit a locked document even on a different replica. B is incorrect 
because no one of any access can edit a locked document. C is incorrect 
because someone with Manager access can unlock a document. C and D are 
incorrect because A is the only correct answer. 

 
QUESTION 106: 
 
Which of the following changes to a form requires updates to existing documents? 
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A. New fields, field names, graphics, and form types. 
 
B. Computed field formulas, text properties, pop-ups, and deleted fields. 
C. Field data types, computed field formulas, form names with a synonym, and static text. 
D. Deleted fields, new fields, form types, and field data types. 
 
Answer: D 
 
Explanation:  
All of these changes require updates to existing 
documents. 

 
QUESTION 107: 
 
Chris has a field that is to be visible to anyone in the [Administration] and 
[Special Reader] roles. The field should not be visible to anyone if the document 
has never been saved. What should the hide/when formula look like? 
 
Answer: C 
 
Explanation:  
The field hides from users who are not in the 
[Administration] role and who are not in the [Special Reader] role, but it 
does not hide from users in these roles. The field will also hide if the document 
is new. A is incorrect because it is entirely a Boolean OR argument. In 
an OR argument, if any part of the argument is true, then all the argument 
is true. In this case, a user might be in the [Special Reader] role, but the field 
field. B is incorrect because if the user is in both the [Administration] and 
[Special Reader] roles, the field hides. The field is supposed to hide from 
users not in these roles. D is incorrect because the field hides if the document 
is not new, that is, unsaved. 

 
QUESTION 108: 
 
Ron opens a view on the Notes client and sees three columns. Sarah opens the same 
view on the Notes client and sees five columns. Why does Ron see fewer columns? 
 
A. Ron is not in the Readers field of the documents. 
B. Ron does not have the appropriate access to the view. 
C. There is a hide/when formula that hides the columns when Ron opens the view. 
D. Sarah has Reader access to the columns Ron cannot see. 
 
Answer: C 
 
Explanation:  
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The Advanced tab in the Column properties box 
allows the designer to check Hide Column If Formula Is True and then type 
in a formula. A is incorrect because if Ron did not have Reader access to the 
documents, he would not be able to see rows (documents), rather than 
columns (document values). B is incorrect because with view restriction, 
Ron would either see the view or not see the view at all. D is incorrect 
because columns are not restricted by Reader access, but through hide/when 
formulas. 

 
QUESTION 109: 
 
Which of the following is not a field type in Domino? 
 
A. Date/Time. 
B. Rich Text Lite. 
C. OLE Object. 
D. Time Zone. 
 
Answer: C 
 
Explanation:  
The Domino field types are text, date/time, number, 
dialog list, check box, radio button, listbox, combobox, rich text, 
Authors, Names, Readers, password, formula, color, rich text lite, and time 
zone. Developers can use an OLE object to incorporate other applications 
such as graphics tools or data sources into their own application. A is incorrect 
because date/time is a field type in Domino. B is incorrect because rich 
text lite is a field type in Domino. D is incorrect because time zone is a data 
type in Domino. 

 
QUESTION 110: 
 
A Maintenance Request form has a Call_Ranking field, which contains the following values: Call Back, 
Routine, Urgent, Non-Routine. Jamal has a view that is 
to be sorted by the Call_Ranking field, but he does not want it sorted in alphabetical 
order. Rather, he wants it sorted in the order of Urgent, Call Back, Non- 
Routine, Routine. How should he do this? 
 
A. Create two columns at the beginning of the view. The first column is visible and both columns are sorted. 
B. Create two columns at the beginning of the view. The first column should be one character wide and sorted. 
C. Create two columns at the beginning of the view. The first column should be hidden and sorted, whereas the 
second column is visible and not sorted. The first column should contain 
 
D. Create two columns at the beginning of the view. The first column should be hidden and sorted by the 
Call_Ranking field. The second column should be visible and not sorted. The second column should contain 
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Answer: C 
 
Explanation:  
The first sorted column, even though it is hidden, 
¡*drives¡ the second non-sorted column and places it in the desired order. A 
may become confused or distracted by the numbers used to sort the call 
rankings. B is incorrect because even though the first column is one character 
wide, it is still visible and distracting. D is incorrect because the first column 
is sorting the column in alphabetical order: Call Back, Non-Routine, 
Routine, and Urgent. 

 
QUESTION 111: 
 
Which of these statements is true? 
 
A. To enter data, users have to type over any hints that appear in data entry fields. 
B. Field hints disappear as soon as a user enters a field. 
C. Field hints disappear as soon as a user enters a field, but reappear in the status bar. 
D. Field hint entries can be entered in the Info tab of the field properties. 
 
Answer: B 
 
Explanation:  
Field hints are added to the Advanced tab in the field 
properties. Although a user can see them in edit mode, field hints disappear 
after the user enters the field. Help Descriptions appear at the bottom of the 
screen in the status bar. A is incorrect because the field hints disappear as 
soon as a user begins typing in the field. C is incorrect because field hints do 
not reappear anywhere after a user begins typing in a field. D is incorrect 
because field hints are added to the Advanced tab of the field properties. 

 
QUESTION 112: 
 
A keyword field displays various accountants¡¦ names from a view categorized by 
department. The list is supposed to be non-repeating, but some accountants are 
appearing more than once. Which formula is causing this error? 
D. All of the above. 
 
Answer: D 
 
 
Explanation:  
DeptView is categorized by department. The keyword 
field should have the names of accountants only. @DbColumn brings in all the 
values of one specified column, and does not accept a specific key, whereas 
@DbLookup can use a specified key to do a lookup in a specific column. The 
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@Unique function takes the returned textlist and removes duplicate values. 
@Sort would simply sort the names in ascending order. A is incorrect because 
using the @DbColumn function would simply bring in all the values in the second 
column, whether they were from the Accounting department or not. B 
is incorrect because the @DbLookup function would have brought in all the 
names in the Accounting department. C is incorrect because it would have 
sorted all the names @DbLookup found from accounting in ascending alphabetical 
order. 

 
QUESTION 113: 
 
A document expires in 30 days, but the owner of the document gets a 48-hour 
grace period. What would be the correct way to set the @Adjust formula? 
 
Answer: B 
 
Explanation:  
The @Adjust function contains these parameters: 
Because days are always 24 hours long, it is correct to add 2 days (48 hours) 
to the 30-day limit, adjusting the date by 32 days. A and C are incorrect 
because not all months (January, February, March, May, July, August, 
October, and December) are 30 days long, as prescribed by the expiration 
requirement. D is incorrect because the parameter for hours was set to 32, 
rather than the parameter for days. 

 
QUESTION 114: 
 
Brenda created a new view called SalesCalendar. Upon opening SalesCalendar, 
users see rows showing icons for the various calendar entries, times, and the 
subject for each entry, but they do not see it in calendar format. What is wrong? 
 
A. The view is missing a column displaying the dates. 
B. The view needs to be refreshed. 
C. The view is not in Standard Outline style. 
D. The view is not in Calendar style. 
 
Answer: D 
 
Explanation:  
Calendar must be chosen in the Style section on the 
View Info tab for the calendar format to appear and display the various entries 
correctly. A is incorrect because the users report that they are not seeing the 
entries in calendar format, not that they are missing data. B is incorrect because 
refreshing a view reflects changes in the documents it displays, not the view¡¦s 
format. C is incorrect because the standard outline view, the most common of 
Notes views that show documents, is not used for displaying calendar format. 
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QUESTION 115: 
 
Aaron wants to print the code of a Java servlet he has imported through the 
Print Source dialog box. Which choice does he make to print the code? 
 
A. Current section. 
B. Current object. 
C. All languages. 
D. None of the above. 
 
Answer: D 
 
Explanation:  
Although the source code for formulas, simple 
actions, LotusScript, HTML, JavaScript, and Java can be printed out, code 
belonging to imported Java programs cannot. 

 
QUESTION 116: 
 
Monika has an agent open in her designer panel, and wants to print all the 
agent¡¦s events. In the Print Source dialog box, she should choose: 
 
A. Current section. 
B. Current object. 
C. All objects¡Xall languages. 
D. Current object¡Xcurrent language. 
 
Answer: B 
 
Explanation:  
Current objects print the source code of the current 
form, button, and so on being worked on. Current objects also allow the 
LotusScript, the designer can choose to print out the formulas only, or print 
out all languages¡Xboth formulas and LotusScript in this example. A is incorrect 
because the Current section prints out what the designer sees in the 
Programmer¡¦s pane. C and D are incorrect because All Objects prints out the 
source code (current or all languages) of all programmable objects (forms, 
buttons, fields, and so on) in the design element currently being worked on. 

 
QUESTION 117: 
 
Which of the following statement is falsePrevent replication or save conflicts by 
 
A. selecting Merge Conflicts on the Form property. 
B. giving users Author access or less in the database ACL to prevent them from editing other users¡¦ documents. 
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C. making as few design changes as possible. 
D. using versioning so that documents can become new documents after editing. 
 
Answer: C 
 
Explanation:  
ACL and design changes do not result in replication 
or save conflicts because the most recent change always takes precedence. A 
is incorrect because merging replication conflicts combines documents if no 
fields are in conflict. B is incorrect because restricting users to editing their 
own documents greatly reduces the chances of any document being edited 
more than once at the same time. D is incorrect because versioning creates 
new documents after editing and saving. The newly edited document is a 
response to the older version, has the older version as a response, or is a sibling 
document to the older version. 

 
QUESTION 118: 
 
What is the editor applet? 
 
A. It is an imported Java applet used to enable Web users to cut, paste, and copy text from outside the editor, as 
well as change the text¡¦s font, size, and color. 
B. It is a native Domino applet that allows Web users to cut, paste, and copy text from outside the editor as well 
as change the text¡¦s font, size, and color. 
C. It is an imported Java applet that allows Web users to bold, underline, and italicize text, create paragraphs 
and 
bulleted lists, and insert links. 
D. It is a native Domino applet that allows Web users to bold, underline, and italicize text, create paragraphs 
and bulleted lists, and insert links. 
 
Answer: D 
 
Explanation:  
Although text that is located within the editor can 
be cut, copied, and pasted, JDK Release 1.0.2 restrictions do not allow pasting 
of text outside of the editor. Editor applets are enabled in rich text fields 
and allow bold, underline, and italicized text, changes in font, size, and color, 
creation and manipulation of paragraphs, use of bulleted and numbered lists, 
and addition of links. A is incorrect because it is a native Domino applet and 
JDK Release 1.0.2 restrictions do not allow pasting of text outside the editor. 
B is incorrect because although the editor is a native Domino applet, JDK 
 
Release 1.0.2 restrictions do not allow pasting of text outside the editor. C is 
incorrect because the editor is a native Domino applet. 
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QUESTION 119: 
 
Is this code correct? 
the ¡*NotesNow¡ article within 3 weeks} 
 
A. Yes. The curly brackets enable the message to include the double quotes around the magazine¡¦s name. 
B. No. The curly brackets are used for commenting code only. 
C. Yes. The curly brackets enable the message to show the magazine¡¦s title in bold type. 
D. No. The prompt title must be in curly brackets as well. 
 
Answer: A 
 
Explanation:  
Curly brackets are used to delimit strings with quotation 
marks, replacing the old method of using a backslash. The curly brackets 
also make it easier to add REM statements to formula language. B is 
incorrect because not only can curly brackets be used to comment code, but 
they also allow strings to include quotation marks without requiring backslashes 
to indicate literal quotation marks. C is incorrect because curly brackets 
are used to delimit strings, not format them. D is incorrect because the 
prompt title is not using literal quotation marks. Curly brackets would be 
useful if the prompt title appeared in this manner: {Information About Your 
¡*Notes Now¡ subscription}. 

 
QUESTION 120: 
 
Tony has given users only Editor access to their own mail databases. Some 
users have reported problems setting their ¡*out-of-office¡ program. What can 
Tony do to alleviate this problem? 
 
A. Give the users Manager access to their mail databases. 
B. Enable the Allow user activation property for the agent running the out-of-office program. 
C. Enable the Run OnBehalf of property for the agent running the out-ofoffice program. 
D. Enable the Restricted operations property for the agent running the out-of-office program. 
 
Answer: B 
 
Explanation:  
The Allow User Activation box is located on the 
Security tab of the agent. When it is checked, it allows users with Editor 
access in the database ACL to enable that particular agent. Enabling the 
agent does not re-sign it. A is incorrect because allowing users Manager 
access can enable them to change their mail forms, create their own agents, 
even delete their own mail database. Providing them with Editor access can 
 
prevent many accidents and mishaps. C is incorrect because Run On Behalf 
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Of allows the designer only to specify on whose authority the agent can run. 
D is incorrect because Restricted Operations lets users who have unrestricted 
rights determine whether or not the agent can run in unrestricted or 
restricted mode. 

 
QUESTION 121: 
 
Which is not a document option for the Agent Menu Selection run option? 
 
A. All selected documents. 
B. All new and modified documents since last run. 
C. Run once. 
D. None. 
 
Answer: C 
 
Explanation:  
Run Once is a document option for the Agent List 
Selection option, found in the Agent window. A and B are incorrect because 
the Document option can be set for either All Selected Documents or for All 
New and Modified Documents Since Last Run. D is incorrect because Run 
Once is not a document option. 

 
QUESTION 122: 
 
Mitchell wants a design element that shows the number of unread documents 
in a folder. What does he need to do? 
 
A. Select the unread rows of the folder Style properties. 
B. Select Show Folder Unread Information on the folder Info tab. 
C. Select Show Folder Unread Information on the folder Options tab. 
D. Select Show Folder Unread Information on the embedded outline Info tab. 
 
Answer: D 
 
Explanation:  
Unread counts for a folder can be shown only in an 
embedded outline, and Show Folder Unread Information is found only in 
the embedded outline Info properties. A is incorrect because Unread Rows 
in the Style tab of a folder control the color in which the unread documents 
appear, and Show Folder Unread Information is selected in the embedded 
outline Info tab. B is incorrect because Show Folder Unread Information is 
selected in the embedded outline Info tab. C is incorrect because Show 
Folder Unread Information is selected in the embedded outline Info tab. 
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QUESTION 123: 
 
Lisa has a view that is updated constantly. What are some better ways to refresh 
 
this view? 
 
A. Use the refresh time option of Auto, After First Use. 
B. Use the refresh display option of the Display Indicator. 
C. Use the refresh display option of Refresh Display from Top Row. 
D. Use the refresh display option of Auto, At Most Over n Hours. 
 
Answer: C 
 
Explanation:  
Because the view is updated constantly, users want 
to see the latest changes. Refresh Display from Top Row would show the latest 
document changes at the top of the view if a reverse chronological display 
is used. A is incorrect because Auto, After First Use shows changes only 
once. B is incorrect because Display Indicator does not show changes unless 
the user clicks on the refresh icon. D is incorrect because the view is constantly 
updated and users need to see the latest changes. Auto, At Most Over 
n Hours would allow users to see only the latest changes hourly. 

 
QUESTION 124: 
 
Which set of commands is listed in the order they are executed? 
D. B and C 
 
Answer: A 
 
Explanation:  
In formula language, assigned variables are executed 
first, then any and all @Formulas. Here are the @Command exceptions that run 
last of all: EditClear, EditProfile, FileCloseWindow, FileDatabaseDelete, FileExit, 
Folder, NavigateNext, NavigateNextMain, NavigateNextSelection, NavigateNextUnread, 
NavigatePrev, NavigatePrevMain, NavigatePrevSelected, NavigatePrevUnread, 
ReloadWindow, ToolsRunBackgroundMacros, ToolsRunMacro, ViewChange, ViewSwitchForm. 
B is incorrect because @Command([ToolsRunBackgroundMacros]) executes last. C is 
because B and C are incorrect. 

 
QUESTION 125: 
 
Steve is writing a view selection to contain the form OriginalThread and all its 
 
response documents. Which selection formula should he write? 
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A. SELECT Form=¡OriginalThread¡ | @AllChildren 
B. SELECT Form=¡OriginalThread¡ | @Responses 
C. SELECT Form=¡OriginalThread¡ | @IsResponseDoc 
D. SELECT Form=¡OriginalThread¡ | @AllDescendants 
 
Answer: D 
 
Explanation:  
The correct answer is D. @AllDescendants returns all response and responsetoresponse 
documents of the parent. A is incorrect because @AllChildren 
returns the first-level response documents. B is incorrect because @Responses 
returns the number of response documents. C is incorrect because 
@IsResponseDoc returns all response documents, whether or not they belong to 
the parent document selected in the view formula. 

 
QUESTION 126: 
 
By default, a user with Author access can 
 
A. create documents and write public documents. 
B. create documents and create personal folders/views. 
C. read public documents only. 
D. create documents only. 
 
Answer: C 
 
Explanation:  
The default privileges for Author access are Read 
Public Documents, Write Public Documents, and Replicate or Copy 
manager. A is incorrect because the privilege to create documents must be 
explicitly checked in the database ACL. B is incorrect because creating documents 
and personal folders/views must be explicitly checked in the database 
ACL. D is incorrect because Write Public Documents and Replicate or Copy 
documents are enabled for Author access as well. 

 
QUESTION 127: 
 
Where does a designer set customized twisties? 
 
A. The View Info tab is where the designer must indicate where the image(s) is/are stored. 
B. The Column Info tab is where the designer must indicate where the image(s) is/are stored. 
C. The View Options tab is where the designer must indicate where the image(s) is/are stored. 
D. Column Advanced tab is where the designer must indicate where theimage(s) is/are stored. 
 
Answer: B 
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Explanation:  
Column Info tab¡Xis where the designer must indicate 
where the image(s) is/are stored. Show Twistie when Row Is Expandable 
must be checked, too. A is incorrect because the Column Info tab, not the 
View Info tab, indicates where the image(s) is/are stored. C is incorrect 
because the Column Info tab, not the View Options tab, indicates where the 
image(s) is/are stored. D is incorrect because the Column Info tab, not the 
Column Advanced tab, indicates where the image(s) is/are stored. 

 
QUESTION 128: 
 
When a user is allowed to customize a view, 
 
A. the user¡¦s resizing and resorting of columns is retained after the view is closed and reopened. 
B. the user¡¦s resizing and resorting of columns is not retained after theview is closed and reopened. 
C. if a user¡¦s ability to customize a view is removed, the user can still resize and sort columns through the 
menu option and the changes are retained after the view is closed and reopened. 
D. A and C. 
 
Answer: A 
 
Explanation:  
The developer can select the Allow Customizations 
make changes in sorting and resizing columns, and their customized changes 
remain in the view even after it has been closed and reopened. B is incorrect 
because the users¡¦ changes are retained in the view. C is incorrect because 
after the ability to customize has been removed, the changes a user has made 
to a view are also gone, with the exception of sorting. D is incorrect because 
B is incorrect. 

 
QUESTION 129: 
 
Pages can contain? 
 
A. Text, fields, and graphics. 
B. Outlines, layers, and frames. 
C. Links, computed text, and embedded objects. 
D. Applets, frames, and text. 
 
Answer: C 
 
Explanation:  
Pages can contain text, graphics, layers, tables, 
links, computed text, embedded objects, and applets. A is incorrect because 
pages cannot contain fields. B and D are incorrect because pages cannot contain 
frames. 
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QUESTION 130: 
 
Which one of the following cannot be used in a column formula? 
 
A. Text field 
B. Checkbox field 
C. Rich text field 
D. Names field 
 
Answer: C 
 
Explanation:  
Rich text, encrypted, and computed for display fields cannot be used for column formulas. 

 
QUESTION 131: 
 
Which one of the following best describes the design element that is a graphical interface that users can use to 
easily access other design elements? 
 
A. Folder 
B. Navigator 
C. Frameset 
D. View 
 
Answer: B 
 
Explanation:  
Views - display a list of documents 
Folder - store and manage related documents 
Navigator - graphic interface for navigation to other elements 

 
QUESTION 132: 
 
Stephen is creating a field where the user selects one of three choices. 
Which field is the best choice for Stephen? 
 
A. Combobox 
B. Checkbox 
C. None of the answers. 
D. Radio button 
 
Answer: D 
 
Explanation:  
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Radio button field type is a mutually exclusive choice field. This is the best choice for Stephen, given the 
requirements. 

 
QUESTION 133: 
 
Which one of the following is not a valid shared resource image type? 
 
A. GIF 
B. MBP 
C. JPG 
D. TIF 
 
Answer: D 
 
Explanation:  
You can create a resource library of images to use throughout your database. Image resources let you maintain 
the image in only one location. If there are any changes to the image, changing and refreshing the source file 
distributes the changes wherever the image is referenced. Shared resource images can be a GIF, BMP or a JPG. 

 
QUESTION 134: 
 
Which one of the following is a new @formula function that allows the Domino developer to write a message 
to the status bar? 
 
A. @StatusBar 
B. @PrintStatusBar 
C. @StatusBarPrint 
D. @StatusMessage 
 
Answer: A 
 
Explanation:  
@StatusBar is used to write a message or messages to the status bar. 
Syntax: @StatusBar( statusBarText ) 
@StatusBar only works in the Lotus Notes client. 

 
QUESTION 135: 
 
Where would Bonnie, the Domino developer, add Field Help for her field labeled Const_Value_Title? 
 
A. Field help is not available in Domino Designer 6 
B. On Field Properties box - Advanced tab of Const_Value_Title 
C. On Form Properties box - Advanced tab of the form. 
D. In the default value of the Const_Value_Title field 
 
Answer: B 
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Explanation:  
Field Help is optional, but it can help users fill out documents without assistance. A field label appears next to 
the field and describes it's general purpose. Write Field Help to tell users what to enter in an editable field or 
how to use the field. When a user selects a field that has Help, a one--line text prompt appears at the bottom of 
the window. 
 
If you cannot fit all the information into a Help description or if the field isn't editable but you want to explain 
its use, use pop-up text in the field label to place Help information directly on the form. You can also write a 
field hint -- text that helps the user determine what to enter or select in the field. The text disappears when the 
user moves the cursor into the field. 

 
QUESTION 136: 
 
Which one of the following best describes how to change from the default twisties to custom graphics? 
 
A. Within the view properties box, add an image resource name in the twistie image box. 
B. Within the database properties box, add an image resource name in the twistie image box. 
C. Within the server properties box, add an image resource name in the twistie image box. 
D. Within the column properties box, add an image resource name in the twistie image box. 
 
Answer: D 
 
Explanation:  
Twisties are used to indicate whether a row or a section may be expanded or collapsed. 
The default design of a twistie is a right-facing and downward facing triangles. In Notes they are green and on 
the Web they are blue. 
You can now choose to use a custom image that has been added as an image resource in the database to be used 
as a twistie. 
In the Designer client you must create an image resource. On the image resource properties box enter "2" in the 
images across box. For more information about "images across," refer to the Lotus Domino Designer Help file. 
Within the column properties box of the view you want to modify select the expandable column and open its 
properties box. Select "Show twistie when row is expandable" and enter the name of the image resource file you 
want to appear. 

 
QUESTION 137: 
 
Which one of the following design elements is a multi-pane interface? 
 
A. View 
B. Frameset 
C. Page 
D. Outline 
 
Answer: B 
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Explanation:  
A frameset is a multi-pane interface that was introduced with R5. 

 
QUESTION 138: 
 
Which one of the following @functions performs a similar function to the print method in LotusScript, and is 
useful for debugging? 
 
A. @StatusBar 
B. @Print 
 
C. @MessageBar 
D. @MessageBox 
 
Answer: A 
 
Explanation:  
@Statusbar - Writes a message or messages to the status bar. Similar to the print method 

 
QUESTION 139: 
 
Which of the following will return the number of elements or a value in a list, even if the value is a null string? 
 
A. Use @Count 
B. Use the @TimeToText to ensure the string is converted from a Date/Time value 
C. Use a Default formula of 1 
D. Use @Elements 
 
Answer: A 
 
Explanation:  
@count 
Example 
Calculates the number of text, number, or time-date values in a list. This function always returns a number to 
indicate the number of entries in the list. 
This function is similar to @Elements, except that it returns the number 1 instead of 0, when the value it is 
evaluating is not a list or is a null string. 
Note This @function is new with Release 6. 

 
QUESTION 140: 
 
@DoWhile will execute one or more statements iteratively while a condition remains _________ 
 
A. True 
B. False 
C. Null 
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D. None of the answers apply 
 
Answer: A 
 
Explanation:  
@DoWhile will execute one or more statements iteratively while a condition remains true 

 
QUESTION 141: 
 
What is the maximum length for a database file? 
 
A. 5 characters 
B. 12 characters 
C. 32 characters 
D. 64 characters 
 
Answer: C 
 
Explanation:  
The database title should be no longer than 32 characters. 

 
QUESTION 142: 
 
Allan needs to determine the number of items in a list. He needs to ensure that he always returns a value 
which indicates the number of entries in the list. If the list is not a list or is a null string, a 1 should be 
returned. 
Which @function should he use? 
 
A. @ListElements 
B. @Count 
C. @Elements 
D. @ListCount 
 
Answer: B 
 
Explanation:  
@Count is used to calculate the number of text, number, or time-date values in a list. This function always 
returns a value to indicate the number of entries in the list. This function is similar to @Elements, except that it 
returns the number 1 instead of 0, when the value it is evaluating is not a list or is a null string. 

 
QUESTION 143: 
 
To enable users to create new Video documents from within a view, you should do which of the following? 
A. 
B. Create a form action that has the following formula : 
C. Create a view action that has the following formula : 
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D. Create a database action that has the following formula : 
 
Answer: C 
 
Explanation:  
 
Answer: C 
 
Explanation:  

 
QUESTION 144: 
 
Which one of the following @functions is used to return the name, customer row, or current column of the table 
that is in focus? 
 
A. @GetTable 
B. @GetName 
C. @RowName 
D. @GetFocusTable 
 
 
Answer: D 
 
Explanation:  
@GetFocusTable - Returns the name, current row, or current column of the table that is in focus. 

 
QUESTION 145: 
 
Which one of the following @functions returns the name of the current field? 
 
A. @Name 
B. @FieldName 
C. @FieldTitle 
D. @ThisName 
 
Answer: D 
 
Explanation:  
@ThisName - Returns the name of the current field. This function is very useful in validation formulas. 

 
QUESTION 146: 
 
Kevin has created an agent that will change the value of a field called "Issued" to the current data time. 
Which one of the following is the correct @formula? 
 
A. Field Issued := @Now 
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B. SELECT Issued becomes @Now 
C. Issued := @Now 
D. Issued = @Now 
 
Answer: A 
 
Explanation:  
The FIELD keyword is needed to set the value of the field. @Now returns the current date-time. 

 
QUESTION 147: 
 
Which one of the following design elements can launch automatically when the database is opened, and can 
contain graphics and hotspots? 
 
A. Form 
B. Table 
C. Outline 
D. Navigator 
 
Answer: D 
 
Explanation:  
A navigator can be launched automatically when the database opens. Navigators can contain graphics and 
hotspots. 

 
QUESTION 148: 
 
Which one of the following @functions could Marla, the Domino developer, use to retrieve an attribute of a 
view? 
 
A. @FetchViewInfo 
B. @GetViewInfo 
C. There is no @function to retrieve view attributes. 
D. @GetViewAttribute 
 
Answer: B 
 
Explanation:  
@GetViewInfo returns a view attribute. This @function is new with Release 6. 
@FetchViewInfo and @GetViewAttribute are not valid @functions. 

 
QUESTION 149: 
 
Which of the actions listed can be used on unopened documents? 
 
A. View action 
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B. Hotspot action 
C. Database action 
D. Form action 
 
Answer: A 
 
Explanation:  
Example 
You can create an unshared action in a view, folder, form, page, or subform to provide one-click shortcuts for 
routine tasks in a view or document. Actions become part of a design element's design and are not stored with 
individual documents. You can also create a shared action in a database that can be used in multiple views, 
folders, pages, forms, and subforms. Shared actions are stored as shared resources in the database. To build an 
action, you can use any of the following: 
Simple actions that you select from a list 
Formulas 
LotusScript 

 
QUESTION 150: 
 
Kevin needs to return the values of an HTTP request header. 
Which one of the following @functions will accomplish this? 
 
A. @GetHTTPHeader 
B. @GetHTTPHeaderData 
C. @SetHTTPNameSpace 
D. @SetHTTPHeader 
 
 
Answer: A 
 
Explanation:  
In a Web application, @GetHTTPHeader returns the value of an HTTP header from the browser client request 
being processed by the server. 

 
QUESTION 151: 
 
Which one of the following @functions can be used to return a view attribute? 
 
A. None of the answers apply. 
B. @GetViewAttribute 
C. @FetchViewInfo 
D. @GetViewInfo 
 
Answer: D 
 
Explanation:  
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@GetViewInfo returns a view attribute. This @function is new with Release 6. 
@FetchViewInfo and @GetViewAttribute are not valid @functions. 

 
QUESTION 152: 
 
Libby would like to allow all users to be able to read and edit all documents in the DISCUSSION.NSF 
application. 
What minimum ACL level should she grant all users? 
 
A. Editor 
B. Author 
C. Reader 
D. Manager 
 
Answer: A 
 
Explanation:  
Editor access allows users to create their own documents, edit their own documents, and edit documents created 
by other people. 

 
QUESTION 153: 
 
Where can Declan, the Domino developer, use @Command((OpenFrameset))? 
 
A. Field 
B. Action 
C. Form 
D. View 
 
Answer: B 
 
Explanation:  
@Command((OpenFrameset)) can be used in action formulas and can be used in Web applications. 

 
QUESTION 154: 
 
Which one of the following @functions converts a value with a data type of text or number to a number value? 
 
A. None of these answers apply. 
B. @ToNumber 
C. @Number 
D. @TextToNumber 
 
Answer: B 
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Explanation:  
@ToNumber - converts a value with a data type of text or number to a number value. 

 
QUESTION 155: 
 
Which one of the following describes the design element best suited for displaying a list of documents? 
 
A. View 
B. Folder 
C. Navigator 
D. Frameset 
 
Answer: A 
 
Explanation:  
Views - display a list of documents 
Folder - store and manage related documents 
Navigator - graphic interface for navigation to other elements 

 
QUESTION 156: 
 
Anna, a Domino developer, has converted part of her page to HTML. She is unhappy with the result and 
wishes to convert it back to a Notes design. 
Which one of the following best describes the recommended way to accomplish this? 
 
A. Select the contents that you want to convert to HTML and choose Edit - Convert to Notes. 
B. Chose Edit - Undo Delete 
C. Choose Edit - Undo Conversion 
D. Select the contents that you want to convert to Notes and choose Edit - Convert to HTML. 
 
Answer: B 
 
Explanation:  
 
To convert a design element (form, page or subform) from HTML to Notes, open the design element, select the 
contents that you want to convert to HTML, and choose Edit - Convert to Notes. However, if you have already 
converted the elements to HTML and wish to go back to the Notes design, the Edit - Convert to Notes option is 
not recommended. Instead, you are advised to use the Choose Edit - Undo Delete. 
will render undesirable results converting back and forth. 

 
QUESTION 157: 
 
Colby has used an @function in his application to iterate statements in code while a condition remains 
true. 
Which one of the following @functions did Colby use? 
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A. @DoUnitl 
B. @If 
C. @For 
D. @ForUntil 
 
Answer: C 
 
Explanation:  
@ForUntil and @DoUntil are not valid @functions. 
@For Executes one or more statements iteratively while a condition remains true. 

 
QUESTION 158: 
 
To enable users to create new Video documents from within a view, you should do which of the following? 
E. 
F. Create a form action that has the following formula : 
G. Create a view action that has the following formula : 
H. Create a database action that has the following formula : 
 
Answer: C 
 
Explanation:  

 
QUESTION 159: 
 
Which one of the following @functions would Jack, the Domino developer, use to execute iteratively as long as 
a condition remains true? 
 
A. @Wend 
B. @WhileWend 
C. @While 
D. @If 
 
Answer: C 
 
 
Explanation:  
@While executes one or more statements iteratively while a condition remains true, and checks the condition 
before executing the statements. 
@Wend and @WhileWend are not valid @functions 

 
QUESTION 160: 
 
James has a field that contains URLs to important Web sites. However, many of the links in his field 
contain spaces. 
Which one of the following @functions will convert the string into a URL -safe format? 



190-610 

Actualtests.com - The Power of Knowing 

 
A. @URLEncode 
B. @URLComputeWithForm 
C. @URLEvaluate 
D. @URLString 
 
Answer: A 
 
Explanation:  
@URLEncode is used to encode a string into a URL-safe format. 
Other encoding formats can be supplied such as ISO-8859-1 and UTF-8. 

 
QUESTION 161: 
 
Which one of the following view formulas will display only Order documents that have a status of "Hold"? 
 
A. None of these answers apply. 
B. SELECT @All 
C. SELECT Form = "Order" 
D. SELECT Form = "Order"& Status = "Hold" 
 
Answer: D 
 
Explanation:  
The SELECT keyword retrieves the set of documents that were created with the form "Order". That set of 
documents is then refined, and only documents with a status field equal to "Hold" are shown in the view. 
@AllChildren would return Response documents, which would not be Order documents since they were not 
created with the order form. 

 
QUESTION 162: 
 
Which one of the following @functions can be used to compare two passwords? 
 
A. @Compare 
B. @VerifyPassword 
C. @PasswordCompare 
D. @HashCompare 
 
Answer: B 
 
Explanation:  
@VerifyPassword - Compares two passwords 

 
QUESTION 163: 
 
James wants users accessing the SALES.NSF application with a browser to have a authenticate. 
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Which one of the following is required? 
 
A. Username and Internet password. 
B. Notes ID file and Internet password. 
C. Notes ID file and Notes ID file password. 
D. Username and Notes ID file password. 
 
Answer: A 
 
Explanation:  
To authenticate via a browser a user must supply a username and Internet password. 

 
QUESTION 164: 
 
Edith has edited the code behind a shared action that is contained on every view in her database. 
When will her changes take effect? 
 
A. None of the answers apply. 
B. The changes will take effect immediately. 
C. The database must be compacted for her changes to take effect. 
D. Next time the views containing the shared action are opened, the changes will take effect. 
 
Answer: D 
 
Explanation:  
Changes to shared actions will be updated when the view containing the shared action is opened. If a user is 
currently in the view, they will not see the chaneg until the view is re-opened. 

 
QUESTION 165: 
 
In an application, which of the following would be used to create a Response document with a copy of the 
original document in a collapsible section? 
 
A. @Command((ComposeWithReferenceSection 
B. @Command((ComposeWithCopy)) 
C. @Command((ComposeWithSection)) 
D. @Command((ComposeWithReference)) 
 
Answer: D 
 
Explanation:  
 
Example 
Creates a Response document containing a reference to the main document. 
Note This @command is new with Release 6. 
Syntax 
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Parameters 
flags 
Number. One or more of the following reference attributes. Combine attributes by adding them. If you omit this 
parameter, the document is composed without a reference. 
1 -- Includes a reference to the main document. If you omit this attribute, the document is composed without a 
reference. 
2 -- Includes the body of the main document. If you omit this attribute, includes the reference as a document 
link. 
4 -- Puts the copy of the main document in a collapsible section. Requires flag value 2. 
This flag does not work in Web applications. If you specify this flag, you cannot specify a flag value of 8. 
8 -- Includes the reference as an Internet-style copy of the main document, with a "So-and-so wrote on ..." 
header and each line prefixed by a greater-than sign. Requires flag value 2. Implicitly applies flag value 16. If 
you specify this flag, you cannot specify a flag value of 4. 
16 -- Removes attachments, images, and other large objects from the reference copy, replacing them with text 
statements in brackets. Requires flag value 2. 
32 -- For databases that contain a $ForwardSep subform (as exists in the Release 6 mail template), prefixes the 
reference copy with a forward separator. Requires flag value 2. 

 
QUESTION 166: 
 
Which one of the following agent types would require the least amount of programming experience? 
 
A. Simple action 
B. LotusScript 
C. Java 
D. Formula 
 
Answer: A 
 
Explanation:  
Simple actions make use of an Add Action button that lets you choose from a set of built-in tasks, making this 
the option that requires the least amount of programming skill. 

 
QUESTION 167: 
 
Herman has placed the @function @DocLock behind a button on a document. 
Which one of the following best describes what the @function will perform? 
 
A. All of these answers apply. 
B. @DocLock unlocks the current document. 
C. @DocLock locks the current document. 
D. @DocLock checks the locked status of the current document. 
 
 
Answer: A 
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Explanation:  
@DocLock is used to lock and unlock a document. @DocLock will also return the locked status of the current 
document, and will indicate if the database has document locking enabled. 

 
QUESTION 168: 
 
Which of the following would be used to write an agent that permanently deletes documents from a database 
that has soft deletes enabled? 
 
A. @SoftDeleteDocument 
B. @ActiveDocumentSoft 
C. @DeleteDocument 
D. @HardDeleteDocument 
 
Answer: D 
 
Explanation:  
@HardDeleteDocument permanently removes the document currently being processed from the database if the 
database has soft deletions enabled. If the database does not have soft deletions enabled, 
@HardDeleteDocument performs the same action as @DeleteDocument. 

 
QUESTION 169: 
 
Which @function should you use to get the name of the current field? 
 
A. @ThisField 
B. @ThisValue 
C. @FieldName 
D. @ThisName 
 
Answer: D 
 
Explanation:  
Returns the name of the current field. 
Note This @function is new with Release 6. 

 
QUESTION 170: 
 
Which one of the following formulas should be used to determine the number of business days (Mon-Fri) 
between the two dates stored in the fields "StartDate" and "EndDate"? 
 
Answer: C 
 
Explanation:  
 
Returns the number of business days in one or more date ranges. 
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This agent displays the number of days in 2001 excluding Saturdays, Sundays, and 10 holidays. 
@Text( 
(01/01/2001) : (01/15/2001) : (02/16/2001) : (05/28/2001) : (07/04/2001) : 
(09/03/2001) : (10/08/2001) : (11/22/2001) : (11/23/2001) : (12/25/2001)) 
"Business days in 2001") 
2. This agent displays the number of days in each quarter of 2001 excluding Saturdays, Sundays, and 10 
holidays. 
@Implode(@Text( 
(01/01/2001) : (01/15/2001) : (02/16/2001) : (05/28/2001) : (07/04/2001) : 
(09/03/2001) : (10/08/2001) : (11/22/2001) : (11/23/2001) : (12/25/2001)) 
"Business days in 2001 by quarter") 
3. This field value formula returns the number of days from StartDate to EndDate, inclusive, less 
NonWorkDays and Holidays. StartDate and EndDate are time-date fields with scalar values. NonWorkDays is a 
keyword field with alias values of "1" and "7" for Sunday and Saturday. Holidays is a time-date field that 
allows multiple values. 
Holidays) 
4. This code, when added to a view action in a calendar view that contains a multiple-day event, displays a 
dialog box that shows the number of business days in the event. For instance, if, in your calendar view, you 
include a Vacation event that lasts for 32 days (startDT field is 08/02/2002 and endDT field is 09/02/2002), 
when a user selects the Vacation event from the calendar and clicks on the button, a dialog box appears entitled 
"Business days" that displays 22. 
To account for a holiday on September 2, edit the formula as follows: 

 
QUESTION 171: 
 
Which one of the following best describes a note? 
 
A. None of the answers apply. 
B. An email message in the Lotus Notes inbox. 
C. A record contained in a Lotus Notes database. 
D. A document contained in a Lotus Notes Database. 
 
Answer: C 
 
 
Explanation:  
A note is a record contained in a Lotus Notes database. For example the following items are all notes: 
Document 
Form 
View 
Agent 
Frameset 
Folder 
Outline 
etc. 
A note is usually represented as a document element or as a defined design element, such as a form or view. 
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QUESTION 172: 
 
Which one of the following @functions executes one or more statements iteratively while a condition remains 
true, and checks the condition before executing the statements? 
 
A. @Wend 
B. @WhileWend 
C. @While 
D. @If 
 
Answer: C 
 
Explanation:  
@While executes one or more statements iteratively while a condition remains true, and checks the condition 
before executing the statements. 
@Wend and @WhileWend are not valid @functions 

 
QUESTION 173: 
 
Which one of the following @functions can be used to build a time-date value from separate date, time and time 
zone values? 
 
A. @TimeMerge 
B. @TimeZone 
C. @TimeCompare 
D. @BuildTime 
 
Answer: A 
 
Explanation:  
@TimeMerge - Builds a time-date value from separate date, time, and time zone values. 

 
QUESTION 174: 
 
James wants users accessing the SALES.NSF application with a browser to have a authenticate. 
Which one of the following is required? 
E. Username and Internet password. 
 
F. Notes ID file and Internet password. 
G. Notes ID file and Notes ID file password. 
H. Username and Notes ID file password. 
 
Answer: A 
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Explanation:  
To authenticate via a browser a user must supply a username and Internet password. 

 
QUESTION 175: 
 
To create a database that does not accept any new documents or modifications to existing documents, you must 
do which of the following? 
E. Create a new copy of the database. 
F. Create a replica copy of the database. 
G. Use Window's Explorer to create a copy of the database. 
H. Create a replica copy of the database and disable replication on the database properties. 
 
Answer: A 
 
Explanation:  
As you prepare to deploy an application, you must work with your Domino server administrator to create a 
replication plan. Replication allows replica copies of databases to exchange updates. You can replicate both 
design elements and database content between replica copies. Replication can be unidirectional -- allowing you 
to push out design changes but not receive any -- or it can be directional -- allowing changes to be both sent and 
received. Generally you perform design work on one copy of a database -- for example, you might keep a copy 
on your local hard drive -- then you replicate design changes to database replicas on servers. 
The following topics describe the tasks involved with creating and maintaining replicas. If you have full access 
a server administrator to create and maintain replicas. 

 
QUESTION 176: 
 
Which @function can be used to return the value from a specified field? 
 
A. @GetItemValue 
B. @GetFieldValue 
C. @Value 
D. @GetField 
 
Answer: D 
 
Explanation:  
1. This code, when added to a computed field on a form and accessed on the Web or in Notes, displays Hello if 
"Hello" is the default value of the greeting 
field. @GetField("greeting") 
2. This computed field formula multiplies values from two fields. The fields are named by adding suffixes to 
 
the name of the current field. 
@GetField(@ThisName + "_Quantity") * @GetField(@ThisName + "_Cost") 

 
QUESTION 177: 
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Which of the following should be used in required fields on a form to prevent users from generating errors by 
leaving important fields blank? 
 
A. Formula and a transitional 
B. Formula and an input validation event 
C. Default formula 
D. Translation event 
 
Answer: B 
 
Explanation:  
An input validation formula checks the data entered in the field against criteria that you specify. This formula 
executes after the input translation formula. An input validation formula should end with a call to @Success or 
@Failure. 

 
QUESTION 178: 
 
Which of the following lists of steps allow you to use system actions on a form? 
 
A. Nothing. System actions appear automatically. 
B. This cannot be done, system actions are not supported. 
C. Choose Edit>Paste>System Resource and select the system action to appear on the form. 
D. Choose Create - Action - Insert System Actions. 
 
Answer: D 
 
Explanation:  
An action is a formula, LotusScript, JavaScript, or simple (no programming) procedure that you can associate 
with a view, form, subform, or page. You can create a standard action, an action with subactions, a shared 
action, or insert system actions that are supplied with Notes. If you create a standard action, when you open the 
view or page, or open a document based on the form, the action becomes available as a menu command under 
Actions and/or as a button on an action bar. If you create an action with subactions, the parent action is not 
programmable but appears as a button with a drop-down arrow on the action bar. Each programmable subaction 
displays in a drop-down list when the parent action is clicked. If you select Actions from the menu, the parent 
action appears as a menu command and when given focus, displays a list of the available subactions. 
Note Subactions are new with Release 6. 
You can insert the standard system actions, which include action buttons that perform basic functions such as 
forwarding, editing, or sending a document. Additionally, you can create and insert a shared action that you can 
reuse in several different design elements. This enables you to make any updates or enhancements to the 
action's code in one place and it is automatically updated in all the elements that use it. You can conditionally 
suppress availability of an action on the menu or action bar with a "Hide action if formula is true" formula. 
@Commands are not allowed in hide formulas. Actions run on the user's workstation. 

 
QUESTION 179: 
 
Which one of the following is the extension for a Notes template database? 
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A. NTF 
B. NSF 
C. NSF 
D. BOX 
 
Answer: A 
 
Explanation:  
NTF stands for Notes Template Facility. NSF stands for Notes Storage Facility. 

 
QUESTION 180: 
 
Jenny would like to retrieve a list of the address books associated with the Lotus Notes client. She must 
accomplish this using @formula. 
Which one of the following @functions can she use? 
 
A. @GetPublicAddressBook 
B. This is not possible using @formula 
C. @GetAddressBooks 
D. @AddressBooks 
 
Answer: C 
 
Explanation:  
@GetAddressBooks - Returns a list of the address books associated with a client (if the current database is 
local) or server. 

 
QUESTION 181: 
 
Which one of the following lines of code is incorrect and will generate an error? 
 
Answer: A 
 
Explanation:  
@Min is a new @Function in Release 6. 
@Min( number1 ) - returns the lowest number 
Either number1 or number2, whichever is smaller 

 
QUESTION 182: 
 
Which @formula function is used to determine the language tag that defines a user's alternate language? 
 
 
A. @UserNameLanguage(1) 
B. @UserName(Swedish) 
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C. @Name(LanguageOption=1) 
D. @UserName(1) 
 
Answer: A 
 
Explanation:  
indicates that the alternate language is the target of @UserName Language. 
Example 
Returns language tags associated with the user ID. 
Note This @function is new with Release 5. 
Syntax 
@UserNameLanguage( index ) 
Parameters 
index 
Number. Indicates the index of user names. 0 is for primary name and 1 is for alternate name. Numbers greater 
than 1 are not used but reserved for future use 

 
QUESTION 183: 
 
Greg is creating a page for his Domino application. 
Which one of the following design elements is not allowed on a page? 
 
A. Table 
B. Layout region 
C. View 
D. Outline 
 
Answer: B 
 
Explanation:  
Layout regions are not supported on pages. 

 
QUESTION 184: 
 
Which of the following @functions will apply a formula to a multiple value field that has numeric values in a 
lost and return a new list? 
 
A. @Transform 
B. @ListProcess 
C. @ProcessList 
D. @ListEvaluate 
 
Answer: A 
 
Explanation:  
in a list. 
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QUESTION 185: 
 
Which steps below must you accomplish to include a JPG image as the logo for your application? 
 
A. Expand "Shared Code" in the design pane, select "Images" from the list of code and click "New Image". 
B. Expand "Shared Resources" in the design pane, select "Images" from the list of resources and click "New 
Image resource". 
C. Attach the logo file to a document and use the lookup to insert the file into each form. 
D. Paste the logo file to a document and use "Find and Replace" to lookup the file and insert into each form. 
 
Answer: B 
 
Explanation:  
You can create a resource library of images to use throughout your database. Image resources let you maintain 
the image in only one location. If there are any changes to the image, changing and refreshing the source file 
distributes the changes wherever the image is referenced. 
To create a shared image resource 
1. Expand "Shared Resources" in the Design pane. 
2. Select Images from the list of Resources. 
3. Click "New Image Resource." 
4. Select GIF, BMP or JPG in the "Files of type" list. 
5. Select one or more graphic files you want to include as image resources. 
6. Click "Open." The graphic files you selected are added to the list of image resources. 

 
QUESTION 186: 
 
Which one of the following @functions can be used to return the date that the file attached to the current 
document was last modfied? 
 
A. @AttachmentModifiedTimes 
B. @AttachmentLastModified 
C. @LastAttachmentModified 
D. @AttachmentUpdates 
 
Answer: A 
 
Explanation:  
@AttachmentModifiedTimes is used to return the date that the file attached to the current document was last 
modified. 

 
QUESTION 187: 
 
Which one of the following best describes the separator of an alias and a form name? 
 
A. / (forward slash) 
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B. _ (underscore) 
C. | (vertical bar) 
D. \ (back slash) 
 
Answer: C 
 
Explanation:  
The form name and alias are separated by a vertical bar (pipe). 

 
QUESTION 188: 
 
While creating an outline, Henry clicked the Use Outline button. 
What do this do for him? 
 
A. Created a blank structure to populate with forms and views. 
B. Generated a blank page. 
C. Generated an outline with entries for existing views and forms. 
D. Create a blank page and embedded the outline inside. 
 
Answer: D 
 
Explanation:  
The Use Outline button automatically generates a new blank page and embeds the currently open outline in the 
page. 
Click "Use Outline" on the action bar at the top of the Design pane. The embedded outline appears on a new 
page with the default style applied to it. 

 
QUESTION 189: 
 
Which one of the following best describes the difference between NoteID and a UNID? 
 
A. A UNID is unique across all replicas of a database. 
B. Both a NoteID and UNID are unique across all replicas of a database. 
C. Neither a NoteID or a UNID is unique across all replicas of a database. 
D. A NoteID is unique across all replicas of a database. 
 
Answer: A 
 
Explanation:  
The universal ID of a document is a 32-character combination of hexadecimal digits (0-9, A-F) that uniquely 
identifies a document across all replicas of a database. If two documents in replica databases share the same 
universal ID, the documents are replicas. The NoteID will be unique in a database, but will not be unique across 
replicas of a database. 

 
QUESTION 190: 
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Which one of the following can be used with an application that is being developed for both the Lotus Notes 
client and Web clients? 
 
A. All of these answers apply. 
 
B. HTML 
C. JavaScript 
D. Java applets 
 
Answer: A 
 
Explanation:  
HTML, JavaScript and Java applets can be used by the both the Lotus Notes client and Web clients. 

 
QUESTION 191: 
 
Anna, the Domino 6 developer, has made substantial changes to a LotusScript script library. She has 
saved the script without error. However, she knows that there will be errors where she has incorporated 
that script into several other design elements. 
What can she do to find these errors? 
 
A. She can add "Option Recompile" to her script library. 
B. Nothing. All Lotus Script code is automatically recompiled. 
C. She can run her application with the LotusScript debugger on, and step through the errors. 
D. She can recompile all LotusScript code in the database by selecting from the designer menu Tools - 
Recompile All Lotus Script. 
 
Answer: D 
 
Explanation:  
From the designer menu, select Tools - Recompile All LotusScript. This will recompile every piece of 
LotusScript code contained in a database. 

 
QUESTION 192: 
 
Which one of the following @functions can be used to check the level of access a user has to a server? 
 
A. @ServerAccess 
B. @AccessLevel 
C. @AccessControl 
D. @ACL 
 
Answer: A 
 
Explanation:  
@ServerAccess Checks if a user has a specified administrative access level to a server. 
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QUESTION 193: 
 
What minimum access level does Jim need to be able to modify the replication settings and schedule of a 
database? 
 
A. Designer 
B. Editor 
 
C. Author 
D. Manager 
 
Answer: D 
 
Explanation:  
Manager access is required to modify the replication settings and schedule of a database. 

 
QUESTION 194: 
 
Debbie is designing a Notes & Domino 6 application and has the following requirements: 
Her Domino server is RoadRunner/ Certkiller . Her database name is App1.nsf and it's in the 
salesdirectory. She needs to retrieve a list of names from a view called "Customers" in the names column 
(the 5th column in the Customers view) in the Active category. The list needs to be sorted Z to A. 
Which one of the following formulas will return the correctly sorted list? 
A. 
B. 
C. 
 
Answer: C 
 
Explanation:  
@Sort is used to sort a list. There is an optional parameter of (ASCENDING) or (DESCENDING) to control 
the sort order. 
Examples of @Sort: 
@Sort(@ThisValue) 

 
QUESTION 195: 
 
Ted is creating a new database using the DISCW50.NTF template. However, he does not want any 
changes to makes to the new database to be lost when he DESIGN task runs. 
Which one of the following should he do? 
 
A. Check the "Input future design changes" option in the New Database dialog box. 
B. Uncheck the "Inherit future design changes" option in the New Database dialog box. 
C. Uncheck the "Inherit future design changes" option in the New Form dialog box. 
D. None of the answers apply. 
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Answer: B 
 
Explanation:  
By unchecking the "Inherit future design changes" in the New Database dialog box design chanegs will not be 
overwritten by the DESIGN task. 

 
QUESTION 196: 
 
Which types of images can be created to use as image resources? 
 
A. BMP, GIF, JPEG and TIFF 
B. GIF and JPG 
C. BMP and JPG 
D. BMP, GIF and JPG 
 
Answer: D 
 
Explanation:  
You can create a resource library of images to use throughout your database. Image resources let you maintain 
the image in only one location. If there are any changes to the image, changing and refreshing the source file 
distributes the changes wherever the image is referenced. 
To create a shared image resource 
1. Expand "Shared Resources" in the design pane. 
2. Select Images from the list of resources. 
3. Click "New Image Resource." 
4. Select GIF, BMP or JPG in the "Files of type" list. 
5. Select one or more graphic files you want to include as image resources. 
6. Click "Open." The graphic files you selected are added to the list of image resources. 

 
QUESTION 197: 
 
In which of the following will pages not be displayed? 
 
A. View 
B. Frameset 
C. Outline 
D. Within another page 
 
Answer: A 
 
Explanation:  
Pages do not display in views. 

 
QUESTION 198: 
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Which one of the following @functions is used to lock a document? 
 
A. @Lock 
B. @Unlock 
C. @DocLock 
D. @DocUnlock 
 
Answer: C 
 
Explanation:  
and to indicate if a database has document locking enabled. 

 
QUESTION 199: 
 
In which of the following design elements are rich text fields not available? 
 
A. Subforms 
B. Pages 
C. Tables 
D. Forms 
 
Answer: B 
 
Explanation:  
Pages cannot contain any fields. 

 
QUESTION 200: 
 
Which of the following @Commands can be used to restore selected documents in a database with soft delete 
enabled? 
 
A. @Command((EditRestoreDeletion)) 
B. @Command((EditRestireDocument)) 
C. @Command((RestoreDocument)) 
D. @Command((RestoreSoftDeletion)) 
 
Answer: B 
 
Explanation:  
@Command((EditRestoreDocument)) Performs the menu command Edit - Restore. 
This code, when used in the Restore action button on a form, enables you to return a document accessed from a 
soft deletions view called "DeletedDocs" to the view or folder that it was deleted from. 
@Command((EditRestoreDocument)) 
You may want to add a Hide When formula to the Restore action button so it only displays on the form when 
the current document is a soft deleted document. Select the Hide action if formula is true check box and enter 
the following code in the formula window. 
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@ViewTitle != "DeletedDocs" 
2. This code, when added to the Restore action button in a soft deletions view, returns the currently selected 
documents to the respective views and folders from which they were deleted. 
@Command((EditRestoreDocument)) 

 
QUESTION 201: 
 
James has written the following formula to prevent users from adding area codes with more than three 
characters: 
Where should James add this formula? 
 
A. Input validation 
B. Input translation 
C. HTML attributes 
D. Default value 
 
Answer: A 
 
Explanation:  
The input validation is the only place that @Success and @Failure can be used. 

 
QUESTION 202: 
 
Which one of the following levels of access is required to locally encrypt a database? 
 
A. Super user 
B. Manager 
C. Designer 
D. Editor 
 
Answer: B 
 
Explanation:  
You must have manager access to a database to apply local encryption. 

 
QUESTION 203: 
 
Which one of the following @functions can be used to determine the capabilities of a Web client? 
 
A. @Browser 
B. @ClientInfo 
C. @BrowserInfo 
D. @BrowserType 
 
Answer: C 
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Explanation:  
the browser for the current request. 

 
QUESTION 204: 
 
Which one of the following view selection formulas would display main documents that contain the phrase 
" Certkiller " in the Company field as well as all Response documents and Response-to-Response documents to 
the main document? 
 
A. SELECT Company = " Certkiller " & @AllDescendants 
B. SELECT Company = " Certkiller " & @AllChildren 
 
 
Answer: C 
 
Explanation:  
@Contains is needed to search the field for phrase "CertFX" since the wording of the question did not say it 
was exactly equal. Then, with that set of documents selected, the vertical bar and the @AllDescendants 
function add Responses and Response-to-Responses to the original set. 

 
QUESTION 205: 
 
Which one of the following @functions can be used to retrieve the replica ID of a database? 
 
A. @UNID 
B. @NoteID 
C. @RepID 
D. @ReplicaID 
 
Answer: D 
 
Explanation:  
@ReplicaID Returns the replica ID of the current database. 

 
QUESTION 206: 
 
Which of the following statements is a view selection statement that includes documents created with the 
review form and any responses? 
 
A. @SelectForm="Review" | @AllDescendants 
B. @SelectForm="Review" & @AllDescendants 
C. @SelectForm="Review" 
D. @SelectDocuments="Review" 
 
Answer: A 
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Explanation:  
Includes all Response and Response-To-Response documents for parents that match selection criteria. Syntax 
SELECT selectionFormula I AllDescendants 

 
QUESTION 207: 
 
Sam is adding shared resources in the Domino Designer IDE. 
Which one of the following is an available shared resource? 
 
A. Connections 
B. All of the answers apply. 
C. Image data 
D. HTML files 
 
Answer: B 
 
Explanation:  
The following are available as shared resources in the Domino Designer client: 
Images 
Files 
Applets 
Style Sheets 
Data Connections 

 
QUESTION 208: 
 
Which of the following statements is true regarding the following code statement: 
 
A. Can be used in a LotusScript agent to show fields that are missing values. 
B. Can be used as field validation on any field on a form accessed through a Web client. 
C. Can be used as field validation on any field on a form accessed through a Notes client. 
D. Has a syntax error and will not save. 
 
Answer: C 
 
Explanation:  
The @ThisValue and @ThisName are new ND6 @Functions that allow developers to produce more modular 
@Formula code. 

 
QUESTION 209: 
 
Which one of the following keyword fields display all values but allows only one selection? 
 
A. Radio button 
B. Checkbox 
C. Combo box 
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D. Dialog list 
 
Answer: A 
 
Explanation:  
Radio button keyword field displays all values but only allows one selection. 

 
QUESTION 210: 
 
Which one of the following @function can be used in a view selection formula to display all Response and 
Response-to-Response documents of a parent document? 
 
A. @Responses 
B. @AllChildren 
C. @AllResponses 
D. @AllDescendents 
 
 
Answer: D 
 
Explanation:  
Includes all Response and Response-to-Response documents for parents that match selection criteria. 
Syntax 
SELECT selectionFormula I @AllDescendants 

 
QUESTION 211: 
 
Max would like documents created with the San_Diego form and the Dallasform to display in his view. 
Which formula would Max use to accomplish this? 
 
A. SELECT @All Form="San_Diego" | Form = "Dallas" 
B. SELECT Form="San_Diego" | Form = "Dallas" 
C. SELECT Form="San_Diego" & Form = "Dallas" 
D. SELECT Form="San_Diego" >< Form = Dallas" 
 
Answer: B 
 
Explanation:  
The vertical bar within the formula represents the OR statement so documents where Form="San_Diego" or 
Form="Dallas" will be displayed. 

 
QUESTION 212: 
 
Which one of the following field types should be used to display the current date, without storing the value in 
the database? 
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A. Computed When Composed 
B. Editable 
C. Computer For Display 
D. Computed 
 
Answer: C 
 
Explanation:  
A Computed For Display field will not store a value in the database. It behaves like a memory value -- valid 
only while the document is on screen. 

 
QUESTION 213: 
 
Which one of the following should Kristy not include in her Notes application that will be accessed by web 
clients? 
 
A. @If 
B. @Created 
C. @Now 
D. @PickList 
 
Answer: D 
 
Explanation:  
@PickList is one of the @Functions that doesn't work on the web. 

 
QUESTION 214: 
 
What minimum access level does Jim need to be able to modify the replication settings and schedule of a 
database? 
E. Designer 
F. Editor 
G. Author 
H. Manager 
 
Answer: D 
 
Explanation:  
Manager access is required to modify the replication settings and schedule of a database. 

 
QUESTION 215: 
 
Paul would like to retrieve the file path of the initialization file for the NOTES.INI of a currently logged 
in user. 
Which one of the following @functions would accomplish this? 
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A. @NotesINI 
B. @EnvironmentPath 
C. @ConfigFile 
D. @ConfigPath 
 
Answer: C 
 
Explanation:  
@ConfigFile is used to return the file path of the initialization file for Lotus Notes (NOTES.INI). 

 
QUESTION 216: 
 
Of the following formulas, which one will ensure that the form is saved with at least one value in the checked 
field known as "Categories"? 
 
Answer: D 
 
Explanation:  
Example 
Returns 1 (True). Use this function with @If in field validation formulas to indicate that the value entered 
 
satisfies the validation criteria. 
Syntax 
This example returns 1 and allows the document to be saved when the value in the price field is less than 100. 
This indicates that acceptable data was entered when used in an input validation formula. 

 
QUESTION 217: 
 
Which one of the following will cause a section to be collapsed when the form is displayed in the Notes client? 
 
A. Modify the section default property to collapse. 
B. Modify the form properties to display all sections as collapsed. 
C. Modify the "Section opened for reading" property to auto-collapse. 
D. Nothing, sections are always expanded. 
 
Answer: C 
 
Explanation:  
Use sections to group and organize elements on a page or form. Sections work well to present large amounts of 
information in an uncluttered way. For example, if you have two different procedures on a page, and users only 
need to see one at a time, you can put each procedure into a collapsible section so that the users can expand 
only the section that they need. 
To create a section: 
1. Open the page or form. 
2. Highlight the text, graphics, and other elements to include in the section. 
3. Choose Create - Section. 
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To format a section 
1. Select the section and choose Section - Section Properties. 
2. On the Section Title and Border tab, you can: 
Enter a title for the section. Titles can be either text or a formula. 
Use text if the title should be the same all the time. 
Use a formula if you want the title to appear differently under different conditions. 
Select the border style. The border appears around the section. 
Select a border color. 
3. On the Expand/Collapse tab: 
Select options for showing the section expanded or collapsed depending on whether a document is being 
previewed, opened for reading, opened for editing, or printed. 
Select "Hide title when expanded" if users don't need to see the section title when the fields are displayed. 
Select "Show as text when not previewing" so that the user sees the section only when the document is being 
previewed. If the document is being printed or is opened for reading or editing, the user sees the text with no 
visible sign that the text is contained in a section. 

 
QUESTION 218: 
 
Which one of the following best describes the Notes & Domino 6 ODS format number? 
 
A. 45 
B. 39 
C. 41 
D. 43 
 
Answer: D 
 
Explanation:  
The database format (on-disk structure or ODS) is represented by a number. This helps determine what format 
or version the database is. The Domino 6 database format is ODS43. 

 
QUESTION 219: 
 
Which one of the following items can't be added to a page? 
 
A. Fields 
B. Sections 
C. Computed text 
D. Hotspot buttons 
 
Answer: A 
 
Explanation:  
Fields cannot be added to a page. 
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QUESTION 220: 
 
Sandra is creating a page for his Domino application. 
Which one of the following design elements is not allowed on a page? 
E. Table 
F. Layout region 
G. View 
H. Outline 
 
Answer: B 
 
Explanation:  
Layout regions are not supported on pages. 

 
QUESTION 221: 
 
Jack notices a Computed for Display field that contains the formula @Now. 
Which one of the following best describes what will be displayed? 
 
A. The current time, excluding seconds. 
B. The current date and time, including seconds. 
C. The current date and time, excluding seconds. 
D. The current date only. 
 
Answer: B 
 
Explanation:  
@Now returns the current time-date including seconds. 

 
QUESTION 222: 
 
Which one of the following could Hector use @Command((OpenPage)) with? 
 
A. View 
B. Shared action 
C. Frameset 
D. Form 
 
Answer: B 
 
Explanation:  
@Command((OpenPage)) would be used in a shared action. 

 
QUESTION 223: 
 
Which one of the following must be done to prevent editing and replication conflicts? 
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A. Enable document locking at the view level. 
B. Enable the document locking database property. 
C. Create a view. 
D. Add a Profile document to manage locked documents. 
 
Answer: B 
 
Explanation:  
When you set the database property "Allow document locking," users with author access or higher can lock 
documents in that database. Locking a document prevents editing and replication conflicts by ensuring that 
modify a locked document even if they are working on a different replica on the same LAN. Managers of a 
database cannot edit a locked document. However, managers can unlock documents that are locked. 

 
QUESTION 224: 
 
Which one of the following design elements allow you to create multi-pane windows to segment the 
application? 
 
A. Tables 
B. Outlines 
C. Agents 
D. Framesets 
 
Answer: D 
 
Explanation:  
 
Framesets let you create multi-pane windows on segments of the screen. The frames can contain named 
elements like views and forms as content. 

 
QUESTION 225: 
 
Which one of the following allows the user to click a link that will move them to another position within the 
same document? 
 
A. Anchor link 
B. Database link 
C. View link 
D. Document link 
 
Answer: A 
 
Explanation:  
Anchor links move you to another location in the same document. Database links will take you to another 
database, view to another view and document links to another document. 
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QUESTION 226: 
 
@DoWhile iterates statements in code while a condition is met. 
Which one of the following best describes when @DoWhile will continue running? 
 
A. DoWhile executes one or more statements iteratively while the condition is true. 
B. @DoWhile executes one or more statements iteratively while the condition is false. 
C. @DoWhile executes one or more statements iteratively while the condition is null. 
D. @DoWhile executes one or more statements iteratively while the condition is missing. 
 
Answer: A 
 
Explanation:  
@DoWhile will execute one or more statements iteratively while a condition remains true. 

 
QUESTION 227: 
 
Which one of the following best describes how you convert a page, form, or subform to HTML? 
 
A. Use the Macromedia Dreamweaver data provider to render design elements in HTML 4.0. 
B. Open the design element, select the contents that you want to convert to HTML, and choose Actions - 
Convert to HTML. 
C. Open the design elements, select the contents that you want to convert to HTML, and choose Edit - Convert 
to HTML. 
D. Design elements can not be converted to HTML. 
 
Answer: C 
 
Explanation:  
To convert a design element (form, page or subform) to HTML open the design element, select the contents that 
you want to convert to HTML, and choose Edit - Convert to HTML. 

 
QUESTION 228: 
 
Which one of the following may not function properly on the Web? 
 
A. Formula language @functions 
B. JavaScript 
C. HTML 
D. Formula language @commands 
 
Answer: D 
 
Explanation:  
@commands do not function on the web. 
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QUESTION 229: 
 
Which one of the following @functions is used to return a view attribute? 
 
A. @GetViewInfo 
B. @GetViewAttribute 
C. @GetViewProperty 
D. @ViewProperty 
 
Answer: A 
 
Explanation:  
@GetViewInfo - Returns a view attribute.There are 3 attributes to get: CalendarViewFormat, ColumnValue and 
IsCalViewTimeSlotOn. 

 
QUESTION 230: 
 
Which one of the following @functions returns the directory portion of a path name, excluding the file name? 
 
A. @FilePath 
B. @DirPath 
C. @FileDir 
D. @PathName 
 
Answer: C 
 
Explanation:  
file name. 


